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Forward Forward

Forward

PWLPay was developed at Clemson University under contract from the
Federal Highway Administration Western Federal Lands Highway Division
PWLPay (FHWA-WFLHD). James L. Burati, Jr. was the principal investigator and

provided all technical guidance. Thomas P. McAfee, Jr. performed the
computer programming for PWLPay. Bruce E. Wasill was the technical
representative for FHWA-WFLHD.

PWLPay allows users to input any Percent Within Limits (PWL) acceptance
plan, along with the corresponding quality characteristics and their test
results. The software then allows the user to compute payment factors; to
consider the potential impacts of various changes in the process mean,
standard deviation, or both; and to develop and display control charts.

PWLPay should provide a powerful tool for contractors to use to track their
processes, develop control charts, determine payment factors, analyze risks,
and make informed decisions necessary to maximize profit while providing
agencies with the quality product they desire. The software will provide
agencies that do not already have a materials database a simple way of
collecting and tracking contractor and agency test data.
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Chapter 1

PWLPay

PWLPay Capabilities

Getting Started

1 Getting Started

Overview

PWLPay was developed at Clemson University under contract from the
Federal Highway Administration Western Federal Lands Highway Division
(FHWA-WFLHD). The software allows users to input any Percent Within
Limits (PWL) acceptance plan, along with the corresponding quality
characteristics and their test results. The software then allows the user to
compute payment factors; to consider the potential impacts of various
changes in the process mean, standard deviation, or both; and to develop and
display control charts.

PWLPay should provide a powerful tool for contractors to use to track their
processes, develop control charts, determine payment factors, analyze risks,
and make informed decisions necessary to maximize profit while providing
agencies with the quality product they desire. The software will provide
agencies that do not already have a materials database a simple way of
collecting and tracking contractor and agency test data.

PWLPay is not intended to allow development of a statistical acceptance plan,
but rather to allow the determination of the risks associated with a particular
acceptance plan. Other software, such as SpecRisk, is available from FHWA
to assist in developing PWL acceptance plans. PWLPay is intended to be used
as a tool to assist both owners and contractors in their quality assurance (QA)
tasks, including both acceptance and process control. PWLPay allows the user
to

e Input PWL acceptance plans, including acceptable quality limits
(AQL), rejectable quality limits (RQL), sample sizes (n), payment
relationships, specification limits, etc.

e Input test results for the contractor and agency.

e Conduct verification tests, including F-tests and t-tests for both
independent and paired data sets.

o Determine descriptive statistics, including mean, standard deviation,
skewness, and kurtosis, for the input test results.

e Test the input data for normality using both graphical and statistical
hypothesis tests.

e Compute current payment factors.
e Compute projected payment factors.

e Develop and plot Run Charts, as well as Control Charts for
individuals and moving ranges, and for sample means and ranges.

e Play “what if games” to determine the potential impacts of changes
in the process mean, standard deviation, or both.

PWLPay User’s Manual 1-1
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If Obtained Online

If Obtained on CD

Administrator
Rights

Getting Started

Typographical Conventions in this Manual

File » Exit Denotes a menu command. In this case choose Exit from the
File menu. Here is another example: File » Open Project »
Show All Projects means open the File menu, then open the
Open Project submenu, and finally choose Show Al
Projects.

Click OK. Bold text clarifies dialog box items and buttons and PWLPay
commands.

Enter Test 1. Italic text specifies text the user needs to enter.

Installing PWLPay

PWLPay is written to run on all versions of the Microsoft Windows operating
system, including Windows 2000, XP, and Vista. Installing PWLPay is
simple—just run PWLPay’s Setup program and follow its instructions.

If you downloaded PWLPay from a Website, you have probably already run
PWLPay Setup. In case you have not, run the file you downloaded
(SETUP.EXE) and follow the instructions.

If you are installing PWLPay from a CD-ROM, PWLPay Setup will usually
start automatically when you insert the CD-ROM into the drive. If it does
not, run SETUP.EXE and follow the instructions. You can run it using the
Run command on the Start menu, or from the My Documents window.

You must have administrator rights to install PWLPay. Users whose
organizations have particularly strict security policies may need to have their
information technology department revise the user’s permission rights for
PWLPay.

Starting PWLPay

The Setup program installs a PWLPay shortcut on your Desktop. Run this
shortcut to start PWLPay. The program opens to the Home screen. All of
PWLPay’s capabilities can be accessed from this screen, including:

Home

Setup Specs
Setup Project
Analysis

Random Sampling

PWLPay User’s Manual 1-2
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Getting Started

Navigation Tree

ﬁ Reports

These selections are discussed in the following chapters.

The Process for Using PWLPay

The general steps for beginning to use PWLPay are shown below:

1. Use Setup Specs to enter the acceptance characteristics and payment
equations for the various items (e.g., PCC, hot mix asphalt) in the
agency’s specifications.

2. Use Setup Project to enter the items and their specification limits for
a project.

3. Use Random Sampling to determine random sample locations or
times for a project.

4. Add contractor acceptance and quality control test results, as well as
any agency acceptance or verification tests for the project.

5. Use Analysis to perform various analyses on the data for one project
or multiple projects. These analyses could include, for example,
calculation of basic statistics, checks for normality of the entered
data, preparation of run charts or process control charts, statistical
tests to verify contractor test results, and pay factor calculations.

Detailed explanations of the features of PWLPay, as well as instructions on
how to use each of these features, are presented in the following chapters of
this manual.

Format of this Manual

This manual is provided as a PDF file and it is likely that it will most often
be used as an electronic file. For users who wish to print a copy, the manual
is formatted for two-sided printing with a larger left margin to accommodate
binding. If printed on only one side, even and odd pages will be slightly
offset from one another.

PWLPay User’s Manual 1-3
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Chapter 2 The Home Screen

2 The Home Screen

The Layout

PWLPay opens to a Home screen similar to that shown in Figure 2.1. The
Recent Projects section that forms the majority of the screen shows the most
recently created or edited projects. The first time PWLPay is opened, this area
will be empty.

& PWL Pay
File Tools Navigale Help

e 1] By die 7S @V redcral Highway

Home  SetupSpecs  SetupProject  Analysis _ Rondom Sampling _ NavigationTree  Reports @ Administr

Welcome to PWL Pay

Recent Projects Project# Date Modified Date Created

Na recent projects ..

Create New / Edit Project

Database Location: C:\Frogram FilesIFHWAIFWL PaylDatzbase Files\Datzbase mdb

Figure 2.1

Drop down menus for File, Tools, Navigate, and Help appear along the top of
the Home screen. The Navigation Pane is the blue shaded region on the far
right side of the Home screen in Figure 2.1. Note: PWLPay is designed for
use with the Windows default blue Appearance under Display Properties. It
is recommended that PWLPay be used with these default settings.

The File Menu

The options accessible from the File menu are shown in Figure 2.2.

41 PWL Pay

File Tools Mavigate Help

Show Projects not on Home Page

From the File submenu the user can display projects, e.g., File » Open Project
» Show All Projects, that can then be selected for editing or data entry. The
user can also Exit the program from this menu.

Figure 2.2

PWLPay User’s Manual 2-1



Chapter 2 The Home Screen

The Tools Menu

The options accessible from the Tools menu are shown in Figure 2.3.

&% PWL Pay
File Tools MNavigate Help

i Database Options k 3 Locate Database
e Mormality Check ¥ Save Copy of Database
Clear Database

Computation Routines
Load Sample Database

Figure 2.3

On the Tools menu, Database Options opens a submenu with 4 options.
Locate Database opens a window (see Figure 2.4) that allows the user to
browse for and then load an existing database. Save Copy of Database
allows the user to save a copy of the current database. Clear Database
empties the contents of the current database, leaving a blank database. Load
Sample Database loads the sample database that was used to create the
figures in this user’s manual.

& Database Location

Select a database location or allow this software to use
the default database.

[[] Use default database show default location show default connection stri

e |C:"'-.Progrc|m Files"\FHWA\PWL Pay'\Database Files'D | [ Browse... {i

| cancel | | Done |

Figure 2.4

Normality Check on the Tools menu opens a submenu (see Figure 2.5).

&l pWL Pay

File Tools MNavigate Help

3 Database Options r b R =
Normality Chedk 14 Show Normality Check g
Hide Mormality Check dom Sampling  Mavig

Alpha Value 3 0.01

0.02

Computation Routines  #

Welcome to PWL Pay 0.02

0.04
v 0.05 (Default) k

Figure 2.5

The submenu under Normality Check provides the option of selecting Show
Normality Check (selected in Figure 2.5) or Hide Normality Check. This
determines whether or not the program automatically checks data as they are
entered and warns the user when the data appear to have not come from a
normal distribution. This warning is explained in detail later in this manual.

PWLPay User’s Manual 2-2
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Figure 2.6

Figure 2.7

Figure 2.8

The Home Screen

Highlighting Alpha Value opens another submenu that allows the user to
select the alpha value () that the program uses when performing the
automatic test for the normality of the input data. In Figure 2.5 the default
value, a = 0.05, is selected.

Tools » Computation Routines is discussed in detail later in this manual.

The Navigate Menu

The options accessible from the Navigate menu are shown in Figure 2.6.

& pWL Pay
File Tools Navigate Help

Open Navigation Tree

o

The options on the Navigate menu include Home, which takes the user to the
Home screen, and Open Navigation Tree. The Navigation Tree is discussed
in detail later in this manual.

Help

Clicking on Help (see) opens the submenu shown in Figure 2.7. PWL Pay
Manual opens a copy of this user’s manual as a PDF file in another window.
About opens the window shown in Figure 2.8.

'8! PWL Pay
File Tocls Navigate Help

PWL Pay Manual

&% About PWL Pay

Developed at Clemson University

for FH\wWA \western Federal Lands Highway Division

Technical: James L. Burati, Jr.

Programming: Thomas P. McAfee. Jr.
Version 1.0.0 FHwWA-WFLHD: Bruce E. \Wasill
March 2008

Recent Projects

The first time PWLPay is opened, the Recent Projects section will be empty.
As projects are entered into the program, this area shows the most recently
created or edited projects, as shown in the example screen in Figure 2.9.
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& PWL Pay Z‘ E‘
File

Tools Navigate Help

e [ By die 7S @ reccral Highway . ...

Home __ Setup Specs _ SetupProject _ Analysis _ Random Sampling __ Navigation Tree _ Reporls @ Administration

Home

Welcome to PWL Pay Tok oty
Pay Factor Report.
Process Control
Recent Projects Project# Date Modified Date Created
Clemsan Bypass District-3-005-1 ‘Sunday, October 26, 2008 Tuesday, Febnuary 27, 2007
Highway 93 District-3-010 ‘Sunday, October 26, 2008 Tuesday, February 27, 2007
Clemson Bypass Phas  District- 0052 ‘Satuitay, Ociober 25,2008 Tharsday, November 25, 2007
1-26 Dist-1-010 ‘Wednesday, October 22, 2008 Thursday, Getober04, 2007
us-123 Dist-7-011 ‘Wednesday, October 22. 2008 Wednesday, October 03, 2007
SR-28 Dist-7-010 ‘Wednesday, October 22, 2008 Monday. July 02, 2007
Route 76 District-1-006 ‘Wednesday, October 22, 2008 Wednesday, Jure 13, 2007
Athens Freeway Athens-001 Tuesday, July 15, 2008 Thursday, October 04, 2007

Create New / Edit Project

Database Location: C:\Frogram Files\FHWAIPIWL PaylDatabase FilesPIVL-Fay-S:

Figure 2.9

'Eﬁ" The projects are shown in order of the most recent date they were modified.
S The projects are created by selecting the Setup Project option. The program
will not allow the Setup Project option to be selected until at least one
specification has been input to the program using the Setup Specs option.

In Figure 2.9, eight projects have been created. Either left or right clicking
the mouse on a project opens the menu shown in Figure 2.10.

Recent Projects Project #
Clemson Bypass, District-3-005-1
Edit Project District-3-010
Add Test Results District-3-005-2
Open Project 3 Dist-1-010
Delete Project Dist-7-011
SR-28 Dist-7-010
Route 76 District-1-006
Athens Freeway Athens-001

Figure 2.10

Edit Project opens a window that allows changes to be made to the
information, such as item numbers and specification limits, associated with
the project. Add Test Results opens a window that allows test data to be
input or edited. These windows are discussed in detail later in this manual.
The user can go directly to the test result window by clicking the blue Add

Test Result button associated with each project. Open Project and Delete
Project are self-explanatory.
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@ Administration

The Home Screen

The Navigation Pane

The Navigation pane is the shaded region on the far right side of Figure
2.8. It shows the most recent locations that have been visited in the program.
The Navigation pane can be used to go directly to any of these locations by
clicking the mouse on that location.

Miscellaneous Items

The user can create a new or edit an existing project directly by clicking on
the green Create New / Edit Project link (see Figure 2.8) on the Home page.
The storage location of the current database file is shown in the lower left
hand corner of the Home screen.

If the computer has Internet access, clicking on the FHWA logo in the upper
right corner opens the FHWA website in a new browser window, while the
Search box in the upper right corner allows the user to perform a key word
search of the FHWA website.
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Chapter 3

Figure 3.1

Setting Up Specs

3 Setting Up Specs

The Empty Setup Specs Window

The first thing that must be done to use PWLPay is to setup one or more
specifications. The first time that the Setup Specs icon is selected the
window in Figure 3.1 is displayed.

& PWL Pay
File Tools Navigate Help

o = 0 Vi

B SokerSpee— ol Pried— ARt

Select 3 State / Agency
Click a state / agency to bring up PWL Equations
|tems, Charsctenstics, Spec
ESEER = B o Equaion |
Edit List
Add New Pay Relationship
Item Numbers
Equation Type:  No Equation
Add New ftem Number
Please click
Cl & -
Edit List
Sert Order to add a new state /
U,
J agency.
Dawn
Auto Sort
Add Mew Charactenistic double click 1o edit

Select a State / Agency

The user must first select or input the state and/or agency to which the
specification applies. The user selects Edit List to open a window with a list
of states and agencies from which to choose. The user can also add to the list
an agency that is not currently included. Any number of states or agencies
can be added at this time. Figure 3.2 shows an example of the window with
the selection list. In Figure 3.2, two states and one Federal agency have been
selected. The Western Federal Lands agency was added by entering the
name into the Add State / Agency box and selecting Add.

When Done is selected the program returns to the Setup Specs window as
shown in Figure 3.3.

PWLPay User’s Manual 3-1
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Figure 3.2

Figure 3.3

Setting Up Specs

& Add New State

States / Agencies Mot Added Added States / Agencies
~ Georgia
Alaska il South Carolina
Arizona Westem Federal Lands
Arkansas

Calformia

Colorado

Connecticut
Delaware Add ==
Florida
Hawaii

=
linois

Indiana
lowa
Kansas
Kentucky
Louisiana || Delete

[

Add State / Agency

&l pWL Pay
File Todls Navigate Help

5 o O e e

Home  SetupSpecs Setup Project  Analysis _ Rondom Sampling _ Navigation Tree  Reports @ Adm

Selecta State/ Agercy - 1x]
= Click s sme  agenay to g PWL Equations
Georgia liams, Crasciaiaties, Spar | .
T nd Pay Factor Ty uatis
South Carolina Apes S F e Bl N0 Equation

Western Federal Lands

Edit List

Add New Pay Relationship

Item Numbers

Equaion Type: No Equation

Add New ftem Number

Sort Order
Up

Dawn

[¥] Auto Sort

Add New Characteristic ‘double click to edit

Item Numbers

Next, select Add New Item Number to open the Add Item Number window
shown in Figure 3.4 to enter the item number to which the specification
applies.

PWLPay User’s Manual 3-2



Chapter 3 Setting Up Specs

¥ Add Item Number

Item Number.

|p-401]

Existing Characteristics Characteristics belonging fo this item Characteristics used in Composite Pay Factor

OFTIONAL Information:

Maximum pay factor (cap): | |

Minimum pay factor: | |

Add Characteristic

Cancel ] l Save ]

Figure 3.4
Characteristics
The user can select any characteristics from the Existing Characteristics box
to associate with this item number. If the Existing Characteristics box does
not contain the necessary characteristics for the item number, then the user
can select Add Characteristic to open the window in Figure 3.5 and enter the
required quality characteristic and information to be associated with this item
number. Any number of characteristics can be associated with a given item
number. Note that the user can also add characteristics from the Setup Specs
window by clicking Add New Characteristic (see Figure 3.3).
™8 Add Characteristic
Lt istic Name: |[Asphalt Content Equations:
State:  Georgia
Spec Type: |TargetVaIue:TOIerance hd
This characteristic requires an equation
S
Figure 3.5

Spec Type  Since different characteristics have different specification requirements,
selecting Spec Type: opens a drop down menu that allows the user to select
the type of specification that is appropriate for the selected quality
characteristic. As shown in Figure 3.6, there are five different specification
types from which to choose.
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Figure 3.6

Setting Up Specs

™8 Add Characteristic E@g|

Characteristic Name: |Asphalt Content Equations:

State: 3 eorgia

Spec Type: | 1 arget Value = Tolerance hd

Target Value + Tolerance k
Minimum Limit Only

Maximum Limit Only

Bounded Mean = Tolerance

Minimum and Maximum Limit

Target Value * Tolerance. This applies to a characteristic such as asphalt
content where there is a target value with allowable tolerances both above
and below the target value.

Minimum Limit Only. This applies to a characteristic such as concrete
compressive strength where there is only a lower specification limit to be
met.

Maximum Limit Only. This applies in the case of a characteristic such as
percent passing the 0.075 mm (No. 200) sieve for which there is only an
upper specification limit to be met.

Bounded Mean * Tolerance. This might apply in the case of a characteristic
such as aggregate gradation where there is a target value and allowable
tolerances above and below the target, but there might also be a master band
that cannot be exceeded by the allowable tolerances. For example, there
might be a characteristic for which the target was 75 with + tolerances of 10.
But, if there is a master band that requires specification limits to be between
60 and 80, then the allowable lower specification limit would be 75 - 10 =
65, while the allowable upper specification limit would not be 75 + 10 = 85,
but would be limited by the master band to be 80.

Minimum and Maximum Limit. This might apply to a case where there is
not a specific target value, but where there are stipulated lower and upper
specification limits. For example, the specification limits for air content of
portland cement concrete might be 3% to 5%.

Pay Information

In most cases a pay relationship will be assigned to the quality characteristic,
and this relationship can be selected from the list in the Equations: box, or it
can be entered by selecting Add New Pay Relationship. In some cases, such
as if the lot payment factor is to be determined by an expected life approach,
there is no pay relationship needed and the This characteristic requires an
equation box can be unchecked (see Figure 3.5).
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Setting Up Specs

Selecting Add New Pay Relationship allows the user to select from two

options for the pay relationship: Tabular Pay Factors or Pay Equations(s)
(see Figure 3.7).

& Add Characteristic

istic Name:

Asphalt Content

Spec Type:

Figure 3.7

State:

Georgia

|TargetVaIue:TOIerance hd

This characteristic requires an equation

Equations:
Add Mew Relstionshi
Pay Equation(s) !

Tabular Pay Factors  If Tabular Pay Factors is selected, the Add Tabular Equation window shown
in Figure 3.8 is opened so that the pay relationship can be entered.

& Add Tabular Equation

{in CSV format)

Pl

Tabular Equation Name: ||

Import values from a file: |

Number of Pay Factor Columns

| Pay Factor (n=1)

BEHRERIBEZ

1B EENEREEREBEEES

Figure 3.8

If you are unsure of how to
| [ mromse ] setup the CSV file for the
import, please click:
Create the import file for me

Edit item range for selected column
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Entering a Pay
Relationship

Figure 3.9

Figure 3.10

Setting Up Specs

The user can enter a name for the pay relationship in the Tabular Equation
Name: box. The user can then either import a CSV file with the pay
relationship information, or create the payment table with the options in this
window.

The Number of Pay Columns box can be increased to account for the total
number of sample sizes for which there are pay factors in the table, and the
Edit item range for selected column can be selected to enter the range of
sample sizes for which each pay factor applies. Each time the number of
columns is increased, the window in Figure 3.9 pops up to allow the user to
enter the sample size range for the new column. The example in Figure 3.9
shows that the column will include the pay factors for a sample size of n = 3.

Tabular Range Input

Please enter an item range for this column

3 to 3|

[ Cancel ] I Savekj

Figure 3.10 shows the input values for an example pay relationship table.
Clicking on Save saves the pay relationship under the name Example Pay
Table 3-10.

% Add Tabular Equation

Tabular Equation Name: ;.Example Pay Table 3-10
Import values from a file: If you are unsure of how to
(r:CS\.-'format) = | se,; up the CSV file for the
import, please click:
Creste the import file for me
|5_ : I Number of Pay Factor Columns Edit item range for selected column
Pl Pay Factor (n=3) | Pay Facter (n=4) | Pay Factor (n=5) | Pay Factor (n=61t08) | Pay Factor (n=910 12 |~
[100 103 104 105 105 105
99 1.02 1.03 104 104 1.04
53 1.01 1.03 1.03 1.01 1.04
|97 1 1.02 1.03 1.04 1.04
|36 1 1.01 1.03 1.03 1.04
|35 1 1.01 1.02 1.03 1.04
|34 1 1 1.02 1.03 1.03
53 1 1 1.01 1.02 1.03
%2 1 1 101 1.02 1.03
El 1 1 1 1.02 1.02
50 1 1 1 1.01 1.02
|88 1 1 1 1.01 1.02
|88 1 1 1 1 1.01
|87 1 1 1 1 101
|86 1 3 1 2, 1
|85 1 1 1 1 1
24 1 1 1 1 0.99
23 1 1 1 0.99 0.99
82 1 1 0.99 0.99 0.98
181 1 0.99 0.99 0.98 0.98
|80 1 0.93 0.98 0.98 0.97
s 0.93 0.98 0.98 0.97 0.97
|78 0.93 0.98 0.97 0.57 0.96 k.
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Importinga Pay  Clicking Create the import file for me (see Figure 3.8) brings up the
Relationship  window shown in Figure 3.11, which can be used to create a blank CSV file
that can then be used to import the pay relationship.

"% Tabular Import File

Please enter the column ranges below to create the import file:
Minimum Range Maximum Range
L

Open file after it has been created

NOTE: Importing data clears and replaces all data.

Cancel ] [ Continue

Figure 3.11

The Minimum Range and Maximum Range columns are used to input the
range of sample sizes for which the pay factor in the column will apply. The
same sample size ranges used in Figure 3.10 have been entered in the
example window in Figure 3.12.

"% Tabular Import File

Please enter the column ranges below to create the import file:
Minimum Range Maximum Range

3

4

5

8

12

-
[0 RN R ]

NOTE: Importing data clears and replaces all data.

[ Cancel ] IContinue[\L

Figure 3.12

Clicking Continue will create a CSV file and, if the Open file after it has
been created box is checked, the file will be opened in Excel. A portion of

the CSV file for Figure 3.12 is shown in Figure 3.13. The PWL column runs
from 100 down to 0, and a corresponding pay factor must be entered for each
row and column in the spreadsheet.

PWLPay User’s Manual 3-7
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A B e D E F
1 PWL PayFactor(n=31t03) PayFactor(n=4to4)} PayFactor(n=5to5) PayFactor{n=6t08) PayFactor(n=9to012}
2 | 100
2 99
4 93
3 97
6 96
7 95
8 94
9 93
10 92
11 91

Figure 3.13 12| s0

Pay Equation(s)  If Pay Equation(s) is selected in the Add Characteristic window (see Figure
3.7), the Add / Edit Payment Equation(s) window (see Figure 3.14) is opened.
This allows the user a wide range of options for entering a continuous pay
relationship based on one to four separate equations, and allows the user to
input different pay relationships for differing sample sizes.

% Add / Edit Payment Equation(s)

Equation Name:

[ | Pay Factor = By + B,(x) + B,(x)* + B (x)’

Forn =110 200 |

Delete this Pay Equation

Select the number of eguations Plezse enter the sample size(s) this eguation represents:
‘ One b I:I to I:I _Gra ph
View a graph to check constraints
First Equation

(&) Linear Eguation Ba l:l Bp |:|
() Second Order Curvelinear B, |:| B+

() Third Order Curvelinear

PwL Range: from 0 o |:| PwL Range: from 0 to

s ] o |
PWL Range: from 0 to |:| PWL Range: from ? to 100

Figure 3.14
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Figure 3.15

Figure 3.16

Figure 3.17

Setting Up Specs

The user first enters a name for the equation(s). In Figure 3.15, Example
Equation Figure 3-15 has been entered in the Equation Name: box. The
Select the number of equations: drop down menu allows the user to select up
to four equations to represent the continuous pay relationship. Each equation
can be either linear, a second order curve, or a third order curve. The
equation at the top of Figure 3.15 defines the input coefficients for the
equations.

Equation Name: 2 3
Example Equation Figure 3-15 Pq} Factor = BO aF Bl(A‘I+ Bz{x‘j aF le.\')
it e
Forn = 1to 200
Delete this Pay Eguation
Select the number of equations Please enter the sample size(s) this eguation represents:
[wo | oo )
Two b to _Grauh
View a graph to check constraints

Note that by default the input equation(s) apply for sample sizes Forn =1 to
200. These values can be changed by entering a new range in the Please
enter the sample size(s) this equation represents: boxes. If the user wishes to
enter different pay equations for different sample sizes, this can be
accomplished by clicking the Add Tab button, which creates a new equation
input screen and allows the user to enter the range of sample sizes for which
the equation(s) apply. In Figure 3.16, three sample ranges, 3 to 10, 11 to 30,
and 31 to 200 have been entered. The sample size range from 31 to 200 has
one equation for the pay relationship.

Equation Name: 2 3
Example Equation Figure 3-15 Pq} Factor = BO aF Bl( X))+ B2{ X+ 83 (x)
Add Tab Save
Forn =3to 10| Forn = 1110 30
Delete this Pay Eguation
Select the number of equations Please enter the sample size(s) this eguation represents:
- 51 e 20
View a graph to check constraints

Once the number of equations has been selected the coefficients for each
equation must be entered. Figure 3.17 shows a pay relationship based on a
single linear equation that applies to sample sizes from 3 to 10.

Forn=3to 10 | Forn = 1110 30 | Forn = 31to 200
Delete this Pay Eguation

Select the number of equations Please enter the sample size(s) this eguation represents:

One b’ 3 to 10 -— Graph |
“iew a graph to check constraints
First Equation
(¥ Linear Equation Bg 55 Bg
) Second Order Curvelinear 5. | 05 B

(O Third Order Curvelinear

Pw/L Range: from 0 o PWwL Range: from 0 to

PWLPay User’s Manual 3-9
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Figure 3.18

PWLPay User’s Manual

Setting Up Specs

Note that coefficients can be input for only the selected number of equations.
For example, in Figure 3.17 only the coefficients for the first equation can be
input. The other coefficient boxes are inactive. For the example in Figure
3.17, B, = 55 and B, = 0.5. Therefore, the pay relationship is represented by
the equation Pay = 0.5PWL + 55. Also note that with a single equation the
PWL Range: from 0 to box automatically has a value of 100 and requires no
input from the user.

A plot of the pay equation(s) can be shown by clicking the Graph button.
Clicking on Graph in Figure 3.17 provides the plot shown in Figure 3.18.

Multiple Graph ET]

Pay Factor vs. PWL

Equation Name: Example Equation Figure 3-15
110

1DD:

9[):
SD:
?D:

& o
T 60
@
i d
= 50
o 4
40 4
30
20
10
0 T T T T T T T T T T T T T T T T T T T 1
0 10 20 30 40 50 60 70 a0 90 100
Percent Within Limits
Ri;h-:lr:k-:_r graph
DGO ophis TIP: Move the mouse ovar the graph to see data points

Figure 3.19 shows a pay relationship based on two equations—one straight
line (which is really a constant in this example) and one second order curve.
Since more than one equation is used, it is necessary to input the range of
estimated PWL values for which each equation applies. The first equation
applies for PWL values from 0 to 50, while the second equation applies to
PWL values from 50 to 100. The program automatically checks to see if the
equations give consistent values at their points of intersection. If the pay
factors at the intersection for the two equations differ by more than 0.01, a
warning message such as the one in Figure 3.20 is displayed. Note that in
Figure 3.20 the two equations differ in payment by 0.76 at their intersection.
At this point the higher pay factor would be used.

The plot for the pay relationship in Figure 3.19 is shown in Figure 3.21.
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Figure 3.19

A

Figure 3.20

Select the number of equations

‘ Two -

First Equation

(®) Linear Eguation
(O Second Order Curvelinear

(O Third Order Curvelinear

Please enter the sample size(s) this equation represents:

to
o
s 0 |

Pw/L Range: from 0 o

Second Equation

(O Linear Eguation
() Second Order Curvelinear

(O Third Order Curvelinear

METT]
., faosz
.. [0z

PwL Range: from 50 to: |:|

Range mismatches ¥

‘.:) The ranges do not match up. The points are: (50,50) and (50.76,Range 11 to 30). Ranges are checked to be within 0.01 of each other, Would you like to se= the graph anyway?

s ]
PWwL Range: from 0 to |:|

Setting Up Specs

Delete this Pay Equation

View a graph to check constraints

Bg

B4

PWwL Range: from 7 to 100

Figure 3.21

Multiple Graph

Pay Factor vs. PWL

Equation Name: Example Equation Figure 3-19

Pay Factor

10

=

Right click on graph
fior mare options

Percent Within Limits

TIP: Move the mouse over the graph to se= dsta points

1
80 90 100

PWLPay User’s Manual
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Figure 3.22 shows a pay relationship based on four straight line equations.
The plot for this pay relationship is shown in Figure 3.23.

Delete this Pav Eguation
Select the number of equations Please enter the sample size(s) this eguation represents:

‘ Four b to

View a graph to check constraints

First Equation Third Equation
775
(%) Linear Equation By III (%) Linear Equation Bg
() Second Order Curvelinear By () Second Order Curvelinear B, 0.25

() Third Order Curvelinear () Third Order Curvelinear

PWL Range: fram 0 to PwL Range: from 70 to;

Second Equation Fourth Equation

55
(® Linear Equation Bo (®) Linear Equation Bo -
(O Second Order Curvelinear B, () Second Order Curvelinear B,

() Third Order Curvelinear () Third Order Curvelinear
PwL Range: from 30 to: PWwL Range: from 50 to 100
Figure 3.22
Pay Factor vs. PWL
o Equation Name: Example Equation Figure 3-22
100 +
S0
a0
70 4
T 60
i 4
= 50
(=T i
40
30
20
10
0 T T T T T T T T T T T T T T T T T T T 1
0 10 20 30 40 50 60 70 80 50 100
Percent Within Limits
Right click on graph
. OGO Op e TIP: Move the mouse over the graph to se= dsta points
Figure 3.23
Clicking on Save in either the Add / Edit Payment Equation(s) window or the

Add Tabular Equation window returns the user to the Add ltem Number
window in Figure 3.24.
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Figure 3.24

Composite
Pay Factor

Add ==

Figure 3.25

PWLPay User’s Manual

Setting Up Specs

% Add Item Number

Item Number:
P-401
Existing Characteristics: Characteristics belonging to this item: Characteristics used in Composite Pay Factor
[ Aspha Cortent |
IE_I
OPTIONAL Information:
Maximum pay factor (cap): | ‘
Minimum pay factor: | ‘
Add Characteristic
Cancel I [ Save

Any additional characteristics to be associated with the item number can be
entered. All of the input characteristics will appear in the Characteristics
belonging to this item: window. For those characteristics to be used in the
determination of the lot pay factor, highlighting them and clicking on Add>>
will add them to the Characteristics used in the Composite Pay Factor
window (see Figure 3.25).

Once the characteristics for the composite pay factor have been entered, the
user must select one of the options from the Select a Composite Pay
Equation: drop down menu.

%8 Add Item Number

Itemn Number:

P-401

Ezxisting Characteristics: Characteristics belonging to this iten: Characteriztics used in Composite Pay Factor

(T | Asphalt Cantert | B ent |
Buldeg I BT T— Densiy

OPTIOMAL Information: Select a Composite Pay Equation:

I aximum pay Factor [cap): | ‘

Minimurn pay factor: |

‘ M awirurn Pay Factar
Multiplied Individual Pay Factars
Sum Price Adjustments
Expected Life Pay Factor

Add Characteristic

Cancel I [ Save

The possible methods for combining the individual characteristics’ pay
factors into a single composite pay factor for the lot (see Figure 3.25) include
the following:
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Weighted Average. This method assigns a weighting factor to each
characteristic and then sums the products of the individual weighting factors
times the pay factors for the individual characteristics.

Minimum Pay Factor. This method assigns the lot pay factor as the
minimum of the pay factors for the individual characteristics.

Maximum Pay Factor. This method assigns the lot pay factor as the
maximum of the pay factors for the individual characteristics.

Multiplied Individual Pay Factors. This method multiplies the pay factors
(expressed as decimals rather than percents) for the individual characteristics.

Sum of Price Adjustments. This method uses the arithmetic sum of the
differences from 100 for each of the individual pay factors.

Expected Life Pay Factor. This method is based on estimating the expected
life of the as-built product and using the difference between the design life
and the expected as-built life to determine the appropriate pay factor for the
lot. Due to its uniqueness compared with the other methods, the expected life
approach is covered in a separate section at the end of this chapter.

Composite Weights  If the Minimum, Maximum, Multiplied, or Sum composite pay factor is
selected, then no additional input is required. However, if the Weighted
Average method is selected to determine the composite pay factor, then the
weights must be entered for each of the characteristics in the composite pay
equation.

In Figure 3.26, the Weighted Average approach has been selected. Also note
that the Allow me to fill in the equation information when | click Save box is

checked by default. When this box is checked, clicking Save will save the
Add Item Number information and also call up the window in Figure 3.27 to

allow input of the weighting factors for each characteristic.

5 Add Item Number =13
Item Number:
P-401
Existing Charactenstics; Charactenistics belonging to this item: Characteristics used in Composite Pay Factor

Density Density

OPTIONAL Information: Sel_ef:t_a C_o_r!\!)o_si?e_Pay_ _E_quation._

Weighted Average v
Maximum pay factor (cap): s

Allow me to fill in eguation information
Minimum pay factor: when | click Save

Add Characteristic

Cancel l | Save Q

Figure 3.26
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In Figure 3.27, weights have been entered for the two characteristics
associated with this item number. The sum of the weights must be 1.0, and
the program will give a warning message if the user tries to save a
combination of weights that does not sum to 1.

! Composite Weights g@@

Please enter weights for the following composite characteristics:

Compuosite Characteristic Weight

Asphalt Content
Density k]

Enter weights in decimal form

Weight Total: 1 /1.

Figure 3.27

Max / Min  The user also has the option of entering maximum and minimum pay factors
Pay Factors  in the OPTIONAL Information: region of the Add Item Number window (see
Figure 3.26). If entered, these values would override the composite pay factor
in the event that the pay relationship produced a pay factor that either
exceeded the value entered for Maximum pay factor (cap):, or was less than
the value entered for the Minimum pay factor:.

The Completed Setup Specs Window

When the item number information is saved the user is returned to the Setup
Specs window in Figure 3.28. Note that when a state or agency is
highlighted in the Select a State / Agency window, all of the items associated
with that state or agency are visible in the ltem Numbers window. Similarly,
when one of the items is highlighted, all of the characteristics associated with
that item are visible in the Characteristics window. Similarly, when one of
the characteristics is highlighted, the pay relationship associated with that
characteristic is highlighted in the PWL Equations window and a plot of the
pay relationship is shown in the window below the PWL Equations window.

For example, in Figure 3.28, South Carolina has four items associated with it;
item number P-401 has four characteristics associated with it; the pay
equation AASHTO is associated with Asphalt Content, and the pay
relationship is shown as a straight line in the plot. If a different characteristic
were highlighted a different pay relationship and plot might be highlighted
and displayed.

The order in which the characteristics are displayed in the Characteristics
window, which is also the order in which any output regarding the
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characteristics will be displayed, can be changed by clicking on the Up or
Down buttons under Sort Order. Checking the Auto Sort box sorts the
characteristics in alphabetical order.

& PWL Pay

File Tools Navigate Help

= § LE M i 73 N e

Home  SefupSpecs  Setup Project  Analysis _ Random Sampling _ Navigaticn Tree Reports ‘@ Administration

Select s State / Agency

Ciighs stme  sgency s Brng up PVIL Equations

eor liems, Charssinstios, Sped
::‘uum Carolina “Tpes and Fay Faptx Types Bauations: [\ Equation e
Western Federal Lands Table-03
WFL-Level | E‘
Table-05 |
Edit List Curve-02 o

Add Mew Pay Relstionship

Equation Type:  Pay Equation(s)

Pay Factor vs. PWL

120
Add New ftem Number 4l
100
. w0
Air Voids g 1
S0 £
VMA Up * 40
o i
[] Auto Sort 0 T T T T 1
0 40 60 80 100
Percent Within Limits
. Add New Characteristic ST o
Figure 3.28
If, for a characteristic, different pay relationships apply for different sample
sizes (see, for example, Figure 3.16), then there will be multiple lines in the
Pay Factor vs. PWL plot. For example, in Figure 3.29 there are three pay
relationships associated with different sample sizes for the characteristic
Performance Index.
CR ;‘ E‘
File Tools Navigate Help
ﬁ Setup Specs  Setup Project  Analysis Handw!Samp\mg Nay e;%?‘l?ﬁ;?:‘;%g;‘cv e
Select = State / Agency k Home
e %ﬁ?ém”ﬁ’&“&“” PWL Equations Setup Specs
TR Eaiors
Western Federal Lands
Edit List
Add New Pay Relationship
Item Numbers
P-401 Equation Type:  Pay Equation(s)
P-501
B Pay Factor vs. PWL
120 -
Add New ftem Number 1
100 A
Characteristics _ 80
Densil 12
erformance Index w 60+
[rly Ranng ’ Gl E
Up 40 1
Davin 204
] Auto Sort 1
0 20 40 60 a0 100
Percent Within Limits
. Add New Characteristic e
Figure 3.29
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To determine which line applies to which sample size or range of sample
sizes, the user can hover the mouse pointer over any portion of a line to
display a popup with information concerning the sample sizes to which the
line applies as well as the specific values for PWL and Pay Factor where the
pointer rests on the line. This is seen in Figure 3.30 where it shows that the
selected line applies to sample sizes in the Range 4 to 6 and that when

PWL = 80 the Pay Factor = 87.

&l PWL Pay
File Tools Navigate Help

o o [ e

Home  SetupSpecs  Setup Project  Analysis  Random Sampling _ Mavigation Tree  Reports

"\ Federal Highway
@ Administrafion

Select s State / Agency

Georgia Chda PWL Equations
s.C
: Ewoir: (e ova]
Western Federal Lands Table-05
AASHTO
Curve-02
Straight-04
Edit List
Add Mew Pay Relstionship
Item Numbers
P40 Equation Type:  Pay Equation(s)
P-501
EEh5
A Pay Factor vs. PWL
120 - 1) Range:4to6
PUL =80
Add New fiem Humber 1 Pay Factor =87
100
c _ 80
Dens\'ﬁ § T
Perfrmance Index Sort Order i 60
Quality Rating B
Up 40
Down 204
Auto Sort 0 T T T T 1
0 20 40 €0 80 100
Percent Within Limits

Add New Characteristic

Figure 3.30

The Expected Life Approach

In the Select a Composite Pay Equation: drop down menu shown in Figure
3.25 the user can select from six methods for determining the compaosite pay
factor for a lot. The first five are discussed previously in this chapter. The
sixth method, the Expected Life Pay Factor, is quite different in concept from
the first five. It is discussed in depth below.

A thorough discussion of the expected life approach for determining payment
for a lot is well beyond the scope of this manual. It is, therefore, assumed that
the user of PWLPay has a thorough understanding of this approach. As such,
this manual covers only the implementation of the expected life approach
using PWLPay.

A thorough description and detailed discussion of the expected life approach
Reference are p_rese_nted in Optimal Procedures for_Quallty Assurance Specificatons,
- Publication No. FHWA-RD-02-095, April 2003.
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Figure 3.31

Expected Life
Input Procedures

Figure 3.32

Setting Up Specs

Figure 3.31 shows the Setup Specs screen with Iltem P-501 highlighted in the
Item Numbers window. Compressive Strength is highlighted in the
Characteristics window. Note that in the PWL Equations section, for
Compressive Strength the Equations: box has No Equation highlighted. An
item for which the pay factor is determined by the expected life approach
will have no pay equation associated with its characteristics.

& PWL Pay ASE]

File Tools Navigste Help

i = £ (el RFI ATy

S L [-F] EiTE ®
o w0 kO i c2 @ @Wedocidohvey N .o
Home  SetupSpecs  Setup Project  Analysis  Random Sampling  Navigation Tree  Reports @ Administrafion

Select a State / Agency B

Georgia ﬁgﬂ?gﬂ;ﬁ:ﬁ@;@ i B e

South Carolina T P Tyees Fausters ]

Western Federal Lands Table-03
WEFL-Level |
Table-05 ]
AASHTO

Edit List Curve-02 ]

A New Pay Relafionship

liem Numbers

P-401 Equation Type:  No Equation

P-501

P-555

P-T

Add New ftem Number

Characteristics

Compressive Strength

Thickness

Sort Order
Up

Dawn

[¥] Auto Sort

Add Mew Characteristic. double click to edit

Figure 3.32 shows the completed Add Item Number input screen for

Item P-501. Compressive Strength and Thickness have been selected as the
Characteristics used in Composite Pay Factor. Note that Expected Life Pay
Factor has been selected as the composite pay equation.

& Add Item Number |- “E”X‘

Item Number
|p-501 |

Existing Characteristics: Characteristics belonging to this item: Characteristics used in Composite Pay Factor|
Asphalt Content Thickness Thickness

Density
Performance Index
Quality Rating
VMA

OPTIONAL Information: Select a Composite Pay Equation:
Expected Life Pay Factar
Maximum pay factor (cap): l:l
Allow me to fill in equation information
Minimum pay factor: l:l when | click Save

Add Characteristic

[ Caneel | [ save ]
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Figure 3.33

Save

Figure 3.34

PWLPay User’s Manual
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Figure 3.33 shows the completed Add Characteristic input screen for
Compressive Strength as it was entered for use with an expected life
approach for pay factor determination. Note that the This characteristic
requires an equation box is not checked. As a result, the Equations: window
is grayed out and no equation can be assigned to this characteristic. This is
the case for any characteristic that is used in determining an expected life pay
factor.

! Add Characteristic Q@I E|
able-03

e A E C ompressive Strength)

State:  South Carolina
Spec Type: | Minimum Limit Only .

[] This characteristic requires an equation

Cancel Save [z!

When Save is selected in the window in Figure 3.32 the Select An Expected
Life Equation window shown in Figure 3.34 is displayed. This window
allows the user to enter the equation that estimates the expected life for the
pavement based on the PWL values for the various characteristics.

EE&

" Select An Expected Life Equation

Expected Life Equation

Equation Form

o s - Pw s
Expected Life = & B+ By(100 -PWL ey ey 1 ¥ BRUI00-PWLe e 17 Bge

By 2485 B, -0.00914 B, -0.00914 B, B. Bs

[] Include Shape Factor

By Constant B,
B, Compressive Sirength B
B, Thickness Bs

Please select an expected life equation type:
@ Papddi= A+ B

C(R? - R¥)
(1- &%)

1+ INF
o (L+IF)

© Payddi= T+

O Enter linear or polynomial equation(s)

=N

|__Continue i%

The general form for the expected life equation, as shown at the top of Figure
3.34,is

Expected Life = e30+31(100—PWL1)5+Bz(100—PWL2)5+~-~+35(100—PWL5)5

In the above equation, S is a shape factor that defaults to 1 unless the Include
Shape Factor box is checked.
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Pay Adjustment
Input Procedures

Figure 3.35

Figure 3.36

PWLPay User’s Manual
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Once the expected life equation has been entered the user can select from one
of three forms for the pay adjustment equation (see the bottom of Figure
3.34). If the first button is selected as in Figure 3.34, selecting Continue
opens the Pay Adjustment Equation window shown in Figure 3.35 and allows
the user to input the coefficients for the pay adjustment equation.

=S

PayAdj= A+ BC)*

& pay Adjustment Equation
Sample Equation

Please enter the following information

A 4362123
g 6362123
c: 0963

E:
Maximum Expected Life = 12.00112

In Figure 3.35, the values for A:, B:, and C:, the coefficients of the pay
adjustment equation, are entered by the user. PWLPay automatically displays
the value for E:, which is obtained from the expected life equation when the
PWL is 100 for all characteristics in the equation.

Selecting Show Graph displays the plot of the pay adjustment equation
shown in Figure 3.36. As with all other charts in PWLPay, the user can hover
the cursor over any point on the line to display the expected life and pay
adjustment values. The pay adjustment is in dollars per unit, and can be
either positive or negative.

Multiple Graph é]

Pay Adjustment vs. Expected Life

5 417 Expected Life = 8.8
o Pay Adjustment = -2.036402
@
= g
Rk
S ]
& -10 .
.12 .
14 4

-16 -
-18 o

20 +¥r¥+——T—T—TTTT—TTTTTTTTTTTT

Expected Life

Right ciick on graph
for mare optiars

TIP: Move the mouse over the graph to see data points
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Figure 3.37

Calculate

Figure 3.38

Figure 3.39

Setting Up Specs

If the second button is selected in Figure 3.34, selecting Continue opens the
Pay Equation window shown in Figure 3.37 and allows the user to input the
necessary information for the pay adjustment equation.

1 pay Equation g@@

Pay Adjustment Equation

PAYADJ = C(R°-R*)/(1-R") NOTE: PAYADJ = appropriate pay adjustment, applicable to new
pavement or overlay, in same units as C.

20 C = present total cost per unit

sY Units of cost (i.e. sy or m2)
D = design life in years
O = expected life of successive overlays in years
R=(1+INF)[(1+INT).
0.04 INF = long-term annual inflation rate in decimal form
0.08

INT = long-term annual interest rate in decimal form

Pay Adjustment Calculation Tool

Expected Life: 12001 12 Maximum Expected Life = 1200112

Pay Adjustment =

Pay Factor=

Cancel Save
[

The input values for the pay adjustment equation are relatively self-
explanatory. A thorough description and detailed discussion of these values
are presented in Optimal Procedures for Quality Assurance Specificatons,
Publication No. FHWA-RD-02-095, April 2003.

The Pay Adjustment Calculation Tool section at the bottom of Figure 3.37
can be used to determine the pay adjustment, in terms of dollars per unit or as
a percent pay factor, for any value entered into the Expected Life: box. In
Figure 3.38, an expected life of 9.5 years has been entered and once
Calculate is selected the corresponding pay adjustment and pay factor values
are shown.

Pay Adjustment Calculation Toal

Ca\culate Expected Life: 95 Maximum Expected Life = 12.00112

Pay Adjustment = -0.83096 $/SY
Pay Factor = 95.85%

Selecting Show Graph displays the menu shown in Figure 3.39, which allows
the user to select to Graph Expected Life vs. Pay Factor or Graph Expected
Life vs. Pay Adjustment. Figure 3.40 shows the plot of expected life vs. pay
factor for the example shown in Figure 3.37.

Graph Expected Life vs. Pay Factor
Graph Expected Life vs. Pay Adjustment K
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Pay Equation Graph =

Pay Factor vs. Expected Life

120
‘IlD:
1[)[):
QD:
SD:
?D:
ED:

Pay Factor

50

404

30 A

20

10

Expected Life = 9.8 years
Pay Factor = 98.35%
Pay Adjustment = -0.33 §/per SY

Right cfick o graph
for more options

Figure 3.40

6

Expected Life

7

TIP: Move themouse aver the graph to == data paints

Continue

If the third button is selected in Figure 3.34, selecting Continue opens the

Add / Edit Pay Adjustment Equation(s) window shown in Figure 3.41 and
allows the user to input the necessary information for the pay adjustment
equation. The input procedures for this window are similar to those presented
with the discussion of Figure 3.14, except that (x) is now expected life.

% Add / Edit Pay Adjustment Equation(s)

Eguation Mame:
|Epected Le |

Select the number of equations

First Equation
20
(&) Linear Equation Bo -
() Second Order CurveLinear B,

) Third Order Curvelinear

Expected Life Range: from 0 to

Second Equation

76.133
(2 Linear Equation Bo
O Second Order CurveLinear B4 -26.15
(%) Third Order Curvelinear
B 5.212
Ba -.2332
Expected Life Range: from 4 to; I:l

Pay Adjustment = B, + B,(x)+ B,(x)* + B, (x)’

CEX

View  araph to check constrsints

Expected Life Range: from 0 to

00j 0 DO

PwL Range: from ? to 100

[ Cancel ]

Save

Figure 3.41

shown in Figure 3.42.
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Multiple Graph (3]

Pay Adjustment vs. Expected Life

Equation Name: Expected Life

Fay Adjustment

Expected Life

Right click on graph

fOr B optioxs; TIF: Move the mouse ovar the graph to se= datz paints

Figure 3.42
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4 Setting Up Projects

The Setup Project Window

Once one or more specifications have been setup, clicking the Setup Project
icon opens the screen shown in Figure 4.1. Any states or agencies that have
been input using the Setup Specs option are displayed in the Select a State /
Agency to continue window. If any projects have been setup previously and
associated with a state or agency they are displayed in the Select the contract
number window when that state or agency is highlighted.

L]

Figure 4.1

& PWL Pay
File Tools Navigate Help

oo (0 i S e

Gt Selup Project _ Analysis  Random Sampling  Navigation Tree  Reports
p Specs p Proj y i po

Select the contract number

Western Federal Lands

Add New Contract Number

~

Adding a Project

The user must first select the state or agency for which the new project
applies. For example, in Figure 4.1 South Carolina is selected as the agency
and, since the Select the contract number window is empty, no projects have
yet been entered for this agency.

Contract Number  Clicking on Add New Contract Number opens the window shown in Figure
4.2 that allows the user to enter a contract number for the project to be added.
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&' Add Contract Number

Please enter a contract number
for state:

South Carolina |SC—2008—001 |

[ Corcel | [ Se )

Figure 4.2

Project Name  When Save is selected the program returns to the Setup Project window as
and Number  shown in Figure 4.3. The new contract number is highlighted and new
windows are displayed from which project names and numbers can be
1= . . .
assigned to the highlighted contract number.

& PWL Pay
File Tools MNavigate Help

o [0 B o e Feder ey

Home  SetupSpecs  Setup Project  Analysis  Random Sampling _ Navigation Tree  Reports @ Administration

Select a State | A to continue Select the contract number
Georgia SC-2008-001
South Carolina

Western Federal Lands

Add New Contract Number

Select a Project Name { Project Number and click the Continue button

Add New Proiect

Figure 4.3

[~

The Select the contract number window displays all contract numbers that
have previously been assigned to the state or agency highlighted in the Select
a State / Agency to continue window. Similarly, the Select a Project Name /
Project Number and click the Continue button window displays the project
name(s) and number(s) that are part of the highlighted contract number in the
Select the contract number window. Figure 4.4 shows the contract numbers
associated with the state South Carolina and the project names, Clemson
Bypass and Clemson Bypass Phase II, and numbers, District-3-005-1 and
District-3-005-2, associated with contract number SC-2008-001.
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&l pWL Pay A=
File Tools Navigate Help

i 3 ] = = i

2 Lo B cifts @
h e 2 Vel ichiey
Home  SetupSpecs SetupProject  Analysis  Random Sampling  Navigation Tree  Reports @ Administration

Select the contract number [~ R

SC-2008-001

New Project / Edt Mode

Western Federal Lands

Add New Contract Number

Select s Project Name / Project Number and click the Continue button
Clemson Bypass District-3-005-1

Clemson Bypass Phase I District-3-005-2
£cd New Proiect
Figure 4.4 s L
Clicking Add New Project opens the Project Setup window shown in Figure
4.5. In this figure, the user has entered Clemson Bypass Phase Il as the
Project Name and District-3-005-2 as the Project Number for the new
project. Also note that all of the item numbers that have been associated with
South Carolina are displayed in the Items in South Carolina Not Added to this
Project window.
& Project Setup |Z]IE]®
Project Name Items in South Carolina Not Added to this Project ltem belonging to this Project
Project Number P-777 -
District-3-005-2 | P-555
[L<<Remore |
Equation Name; |
Equation Type; |
Spec Type: |
Please lete the following information:
[ Cancel | [ save |
Figure 4.5
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Adding Project Details

Items  The Project Setup window, shown in Figure 4.5, allows the user to input
project-specific information regarding the type of project, as represented by
the associated item numbers, and the specification limits for the project. The

Add >> user highlights an item number and then uses the Add >> button to select it
for the project. Any number of item numbers can be assigned to a given
project.

In Figure 4.6, items P-401 and P-501 have been added to the project as
shown in the ltems belonging to this Project window. The characteristics
associated with the highlighted item are shown in the box in the lower left
corner of the Project Setup window. Figure 4.6 shows that the characteristics
Asphalt Content, Air Voids, VMA, and Density are associated with item

¥ Project Setup g@@
Project Name Items in South Carelina Net Added to this Project ltem belonging to this Project

Clemson Bypass Phase || P-555 P-401

P-777 T P-501

Project Mumber
District-3-005-2
= < Charactenistic’s Equation Information
Air Voids
Asphalt Content Equation Name: AASHTO
Densi : ;
VMA ty Eguation Type: Multiple Equation
Spec Type: target value + tolerance
Please complete the following information:
Target Value
Tolerance
NOTE: Characteristics in this box balong 1o the
selected ITEM in the “ltems belonging to this
Project” b,
Cancel ] [ Save
Figure 4.6

Spec Limits  The Project Setup window is also used to enter the specification limits for
the various characteristics associated with each of the item numbers
associated with the selected project. In Figure 4.6, the Characteristic’s
Equation Information box displays detailed information regarding the
specification requirements for the characteristic that is highlighted in the box
in the lower left corner of the window. This is also where the specification
limits for the characteristic are entered for the selected project.

Figure 4.6 shows that the characteristic Asphalt Content uses the pay
equation named AASHTO, that the pay equation type is Multiple Equation (as
opposed to using Expected Life), and that the specification has a target value
with £ tolerance limits. The user must enter the specification limits for all
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characteristics before the project setup information can be saved. If the Save
button is clicked before all limits have been entered a message such as that
shown in Figure 4.7 is displayed.

Characteristic Info Not Entered

6 Al of the information for the characteristics have not been entered. Would you like to enter this information now? Missing information:
Item: P-401

Characteristic: Air oids
Property: Target Value and Tolerance

Figure 4.7 == F

Figure 4.8, which is the bottom portion of the Project Setup window, shows
that for the characteristic Density, the pay equation is Curve-02 and the
specification has both a minimum and maximum limit, with a Minimum Limit
of 92.0 and a Maximum Limit of 96.5.

= = Charactenistic’s Equation Information
Air Voids
Curve-02

ASEha|t Content Equation Name:
Multiple Equation

VMA Equation Type:

Spec Type: minimum and maximum limit

Please complete the following information:

Minimum Limit

92.0

Maximum Limit

96.5

NOTE: Charscteristics in this box belong tothe
selectad ITEM inthe “ltems balanging to this
Project” bax

Cancel l [ Save

Figure 4.8

Once all of the specification limits have been entered, clicking on the Save

button saves the information in the database and returns the user to the Setup
Project window. Note in Figure 4.9 that the newly added project name,
Clemson Bypass Phase Il, and project number, District-3-005-2, are shown in
the Select a Project Name / Project Number and click the Continue button

Continue window. Clicking on Continue takes the user to the data input screen for the
selected project so that test results can be entered.
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& PWL Pay

File Tools Navigate Help

&8 Y]

Setup Project

@ ‘ Federal Highway

T ‘@ Administrafion

am

Analysis Random Sampling __ Navigation Tree

Select a State | Ac to continue Home

Setup Specs
New Project / Edit Mode

Add Mew Contract Number

Select a Project Name { Project Number and click the Continue button
Clemson Bypass

Clemson Bypass Phase II

Add New Proiect m

Figure 4.9

B
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Figure 5.1

Figure 5.2

Entering Test Results

5 Entering Test Results

The Add Samples Window

The Add Samples window is used to input all test result data for a selected
project. Figure 5.1 shows the Add Samples window for a project before any
test result data have been entered. Project idenification information,
including project name, project number, specification type, and specification
limits, is provided at the top of the screen. There are also two drop down
menus in this region of the window: one for ltem Number: and one for
Characteristic:.

& PWL Pay

File Todls Navigate Help

= v s 4z

Home  SetupSpecs Selup Project  Analysis _ Random Sampling _ Navigation Tree  Reports

Spec Type: k .
ProjectName:  Clemson Bypass i Hiimbor a jome
P-401 . target value + tolerance S,
Project Number:  District-3-005-1 = Torget A
Characteristic: 57 -
Asphalt Content v Tolerance
03
OTE: Click the & {0308 new ems 102 Sop awm b
Lot Number| SampleNo. | Date | TestResult | Contr/Owner | Lab Name | Tester 1D | Split Sample No. | Split Test Result| SplitLsb Name
»
L] L]

Clicking on the project name, Clemson Bypass in Figure 5.1, opens the
Project Setup window for that project. Clicking on the Item Number: drop
down menu displays a selection list of all item numbers associated with this
project (see Figure 5.2a). Similarly, clicking on the Characteristic: drop
down menu displays a selection of all characteristics associated with the
selected item number (see Figure 5.2b).

Characteristic:
Asphalt Content \;
Iltem Number: Air Voids 5

Asphalt Content
P-401 b Density
VMA
) (b)

(a
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Opening the  There are a number of different ways that the user can open the Add Samples
Add Samples  window to allow input of test result data for a selected project. As shown
Window  and noted in Chapter 4, clicking on Continue in the Setup Project window
leads to the Add Samples window for the highlighted project (see Figure
4.9).

The Add Samples window can also be opened two different ways from the
Home screen. Either left or right clicking on the name (Clemson Bypass in
Figure 5.3) of one of the Recent Projects opens the dropdown menu shown
in Figure 5.3. Edit Project opens the Project Setup window. Add Test Results
opens the Add Samples window. Open Project » Show All Projects or Open
Project » Show Projects Not on Home Page allows the user to show
additional projects not shown in the Recent Projects section.

Recent Projects Project#

Clemson Bypass Phas  District-3-005-2

Clemson Bypass District-3-005-1
Edit Project Dist-1-010
Add Test Results ‘ Dist-7-011

| Sondirass ]

i Show Projects Mot on Home Page |

Delete Project

Athens Freeway Athens-001

Highway 93 District-3-010

Figure 5.3

The Add Samples window can also be opened directly for a project in the
T 71 Recent Projects list by clicking on the Add Test Result button at the end of
the row in which the project appears (see Figure 5.4).

Recent Projects Project # Date Modified Date Created
Clemson Bypass Phas  District-2-005-2 Saturday, Ootober 25, 2008 Thursday, November 28, 2007 l:l
Clemson Bypass District-3-005-1 Saturday, Ootober 25, 2008 Tussday, Februzry 27, 2007 l:l
1-26 Dist-1-010 Wednesday, October 22, 2008 Thursday, Ootober 04, 2007 l:l
us-123 Dist-7-011 Wednesday, October 22, 2008 Wednesdzy, October 03, 2007 l:l
SR-28 Dist-7-010 Wednesday, October 22, 2008 Monday, July 02, 2007 l:l
Route 76 District-1-0056 Wednesday, October 22, 2008 Wednesday, June 13, 2007 l:l
Athens Freeway Athens-001 Tuesday, July 15, 2008 Thursday, Ootober 04, 2007 l:l
Highway 93 District-3-010 Wednesday, Juns 13, 2007 Tuesday, February 27, 2007 l:l

Figure 5.4

Entering Test Results

Test result data can be entered directly into the section of the Add Samples
screen that has the appearance of a spreadsheet (see Figure 5.1). Test result
data can also be imported from a CSV (comma separated variables) file that
was most likely created using a spreadsheet program.

Data Columns  Test result data can be entered in the Add Samples screen as they would be

entered into a typical spreadsheet. Figure 5.1 shows some of the column
headings for which data can be entered for a project.

PWLPay User’s Manual 5-2



Chapter 5 Entering Test Results

The columns for which data can be entered include:

Lot Number: alpha-numeric lot number to which the test result is
associated.

Sample No.: alpha-numeric sample number within the lot.

Date: can be entered in any typically accepted format, e.g., 2-4-07, or
02/04/07, or 2/4/2007, etc. The program automatically converts the date to
a standard format.

Test Result: test result for the lot/sample number combination.

Contr/Owner: indicates whether the test was performed by contractor or
owner personnel.

Lab Name: name of the laboratory where the test was performed.

Tester ID: alpha-numeric identification number for the technician who
performed the test.

Split Sample No.: alpha-numeric identification number for the owner’s
portion if split samples are used.

Split Test Result: test result for the owner’s split sample for the lot/sample
combination.

SplitLab Name: name of the laboratory where the split sample was tested.

Split Tester ID: alpha-numeric identification number for the technician who
performed the split sample test.

Remarks: whatever comments or additional information the user wishes to
add.

Due to the way in which PWLPay and spreadsheet programs sort data, it is
important that care be taken when assigning and entering lot and sample
numbers. Since lot and sample numbers may have letters as well as numbers,
to be sorted properly, they must be recognized as “text” by either PWLPay or

a spreadsheet program. To ensure that this happens without having to
remember to declare the cells as text, it is recommended that the user always
include a letter as well as numbers when assigning lot and sample numbers.
For example, it is preferable to enter L001, L-001, or Lot-001 rather than 001
for the lot number.

It is also important that lot and sample numbers are entered with a consistent
number of places. For example, if lot numbers were entered as L-1, L-2, L-3,
L-4, L-5, L-6, L-7, L-8, L-9, L-10, L-11, when sorted by lot number the
order of display would be L-1, L-10, L-11, L-2, L-3, L-4, L-5, L-6, L-7, L-8,
L-9. This problem can be avoided simply by entering leading zeros so that all
lots or samples have the same number of values. In the previous example, the
lots would be displayed in the proper order if the numbers were entered as
L-01, L-02, L-03, L-04, L-05, L-06, L-07, L-08, L-09, L-10, L-11.
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Entering Data  Test information and results are entered as in a typical spreadsheet program.
Figure 5.5 shows the spreadsheet format data entry section of the Add
Samples window before any test result information has been added for the
characteristic Asphalt Content.

Asphalt Content v Tolerance
03
MOTE: Click the & to add new items 1o 2 drop down baos
Lot Number | Sample No | Date | Test Result | ContriOwner | Lab Name | Tester ID | Split Sample No. | Split Test Result| SplitLab Name
3

Figure 5.5

Figure 5.6 shows the same section of the Add Samples screen while data

entry is underway for the first sample for the project. Once any values are
input, the Save Table button (see Figure 5.5) changes to the Save Needed
button to remind the user to save the input data after entry (see Figure 5.6).

Save Meeded
Note that the input data will be lost if not saved before exiting from the
current characteristic. If the user tries to change characteristics before saving
the input data, a warning window pops up (see Figure 5.7).
Save Needed Tolerance
03
- |=Lm -N-urr:ber|_°->a=r-n-p\;}4|;. : "‘-D;t;. - | Test Result | Contr/Owner | Lab Name | Tester ID_| Split Sample No. | Split Test Result| SplitLab Name
ﬂL—DDT 501 10508
Figure 5.6 *
03
‘zLotl-Vru.rr:ber‘;E-S;r-n-pl:N; |Da|e | TestResult | Contr/Owner | Lab Name | Tester ID | Split Sample No. | Split Test Result| SplitLab Name
j L-001 501 1052008 565 Contractor 1-Contractor 3456
*
Save Table?
J) Would you like to save the table before switching characteristics?
.
Figure 5.7

The Date format in Figure 5.7 has been automatically changed from the value
10-5-08 (see Figure 5.6) that was input to the standard format used by

PWLPay.
Asphalt Content v Tolerance
03
NOTE: Clickthe 4 1036d new items to rop down bo
| Lot Number | Sample No. | Date | Test Result | ContriQwner | Lab Name | Tester ID | Split Sample No. | Split Test Result| Splitlab Name
ﬂL—Dm 50 10552008  5.65 v |~
*

Figure 5.8 e —

The Contr/Owner column (see Figure 5.8) indicates which party conducted
the test and has a limited number of input values. As shown in the NOTE
above the spreadsheet section, these allowable values are entered initially by
clicking on the = symbol. This displays the drop down window shown in
Figure 5.9a. Two possible input values have been entered, Contractor and
Owner. Clicking Ok sets these as the only two possible values. The cell will
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now auto-complete. That is, for example, entering ¢ will cause Contractor to
be the input value.

Once the allowable values have been entered, clicking on the drop down
arrow, ¥, displays the input options for this column, i.e., Contractor or
Owner in Figure 5.9b.

|_Cont'.f0wner | Lab Namr

Cortrac + h

Name

Contractor

Owner

b
| Contr/Owner |
T e
Contractor

Figure5.9 (a) [2°2 _ x o« (b) niz=

Similarly, the Lab Name and Tester ID columns are limited to values that
have been input in the same manner. See, for example, Lab Name in Figure
5.10. Names for all labs in the state could be entered all at one time and in
such a way that allows the auto-complete function to save time. For example,
if the state had seven district labs, rather than entering them as District-1,
District-2, etc., it would be better to enter them as 1-District, 2-District, etc.
In the first case, entering D would not allow auto-completion since seven
labs begin with D. However, in the second case, entering 1 would auto-
complete 1-District (provided there were no other lab names beginning with
1).

NOTE: Click the & 10 2dd new items to 2 drop down box

Lat Number\ Sample No. | Date | Test Result | Contr/Owner | Lab MName | Tester ID | Split Sample No. ‘ Split Test F‘.ﬁult|
¥ 001 ma 1252007 482 Contractor 1-Cortractor |« |
& Lab Name

1-Contractor
1-District

7-Dist

Sloan-001
Sloan-1
*

4of6 x [0E

Figure 5.10

The SplitLab Name and Split Tester ID columns work in similar fashion to
the Lab Name and Tester ID columns.
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Importing Data

Figure 5.11

Entering Test Results

Test information can also be imported in the form of a CSV file. In this way
a spreadsheet could be used to maintain the data and then the file could be
saved as a CSV file and imported into PWLPay. This would also allow
existing data, with some adjustments in columns and column titles, to be
quickly and easily entered into PWLPay.

Right clicking the mouse anywhere in the Add Samples window opens the
drop down menu shown in Figure 5.11. Only the Import Data option is
considered here. The other choices on this menu are covered later in this
chapter.

Selecting Import Data opens the Import Test Results window shown in Figure
5.12, which allows several options for importing data from an existing CSV
file. The user can browse to locate the file to be imported. The default for
Import Data Format: is All Data. The dropdown menu in Figure 5.12 shows
all of the import options.

&l pWL Pay
File Todls Navigate Help

o 29 L i @

Home Setup Specs _ Setup Project _ Analysis __ Random Sampling __ Navigation Tree Reports

" e way
@ Administiation

Type: g
ProjectName:  Clemson Bypass ftem Number. oo Ty a

P-401 T target value & tolerance
e New Project / Edt Made
Project Number:  District-3-005-1 T
Characteristic: o Aok o
Asphalt Content v Tolerance

03

ckihe A to2dd new items to

Lot Number | SampleNo. | Date
>

| TestResult | Contr/Owner | Lab Name | Tester ID_| Split Sample No. | Split Test Result| SplitLab Name

Delete Row
Delete Cell

e

Export Data

Print Preview

Print Grid

Analyze This Characteristic

Analyze This Ttem

Random Sampling
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Figure 5.12

! |mport Test Results [Z”E”z\

CSVFile Location: | | browse ...

This file has a header row (first row will not be read)

Import Data Format:

) State
ir[.-l.:t.fn:é”f: Contract Number =
Project
ltem ers
Characteristic

CSV File Input format for selected import type:

State / Lgency, Contract Number, Project Name, Project Number, Item Number,
Characteristic Name, Lot MNumber, Sample Number, Date, Test Result,
Contractor/Owner, Lab Name, Tester ID, Split Sample Number, Split Test
Result, Split Leb Name, Split Tester ID, Remarks

Create a blank file with these columns for me

Import Progress: Awaiting Import

Entering Test Results

The Data will be imported for: window, shown in Figure 5.13, indicates that
All Data allows for input of data from multiple states as well as multiple
contracts, multiple projects, multiple items, and multiple characteristics for
each project. This import format probably would not be used often. A
different import format can be selected by clicking ~ to open the drop down

menu shown in Figure 5.12.

& |mport Test Results E”E”g‘

CSVFile Location: | | [(browse ..

This file has a header row (first row will not be read)

Import Data Format: All Data o

Data will be

. State [ Agency: All States [ Agencies
imported for:

Contract Number: All Contracts

Project Name: All Project Names
Project Number: All Project Numbers
ltem Number: All ltems

Characteristic Name: All Characteristics

CSV File Input format for selected import type:

State / Lgency, Contract Number, Project Name, Project Number, Item Number,
Characteristic Name, Lot MNumber, Sample Number, Date, Test Result,
Contractor/Owner, Lab Name, Tester ID, Split Sample Number, Split Test

Result, Split Leb Name, Split Tester ID, Remarks

Create a blank file with these columns for me

Import Progress: Awaiting Import

Figure 5.13

Note that the CSV File Input format for selected import type: section lists the
columns for which import data are needed based on whichever Import Data

Format: is selected. For example, the column input titles for All Data are
shown in Figure 5.13.
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Figure 5.14 shows the column input titles when Project is selected for the
Import Data Format: option. Comparing Figures 5.13 and 5.14 shows the
smaller number of input columns required for the Project import format. The
Data will be imported for: window shows that no input is necessary for State,
Contract Number, Project Name, or Project Number since these are
automatically input as shown based on the Project format that is selected.

At this point the user can create a CSV file using the column headings shown
in Figure 5.14, although this can be accomplished more easily by clicking on
Create a blank file with these columns for me. Doing this opens Excel, if it is
on the user’s computer, with a CSV file open with the required column

he_adi_ngs. A sample with the column headings for the CSV file created by
clicking Create a blank file with these columns for me from Figure 5.14 is
shown in Figure 5.15.

& Import Test Results g@g‘

CSVFile Location:
This file has a header row (first row will not be read)
Import Data Format 3
_Data will be State / Agency: South Carolina
imported for: Contract Number: SC-2008-001

Project Name: Clemson Bypass
Project Number: District-3-005-1
ltem Number: All kems
Characteristic Name: All Characteristics
CSV File Input format for selected import type:
Item Number, Characteristic Name, Lot Number, Sample Number, Date, Test

Result, Contractor/Owner, Lab Name, Tester ID, Split Sample Number, Split
Test Result, Split Lsb Name, S5plit Tester ID, Remarks

Create & blank file with these columns for me

Import Progress: Awaiting Import

Figure 5.14

Figu re 5. 15 1 ttem Number Characteristic Name Lot Number Sample Number Date Test Result Contractor/Owner Lab Mame TesteriD Spilit Sample Number Split Test RBesult Split Lab Name Split Tester ID Remarks
The user can then either directly input data into the CSV file in Figure 5.15,
or else import data from an existing spreadsheet into the appropriate columns
in the CSV file. Figure 5.16 shows a portion of the CSV file from Figure 5.15
after project data have been entered.
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In Figure 5.16 note that the lot and sample numbers all contain at least one
letter. This avoids any potential problems with Excel recognizing the input as
Cell Formats numeric rather than alpha-numeric (i.e., Excel treats the cell as “Text”). As
noted previously, entering these values as text allows for proper sorting when
displayed by PWLPay.

Important Note on

Figure 5.17 shows the Add Samples screen after the CSV file shown in
Figure 5.16 has been imported.

&l PWL Pay EE®

File

5 o ol P die LY f.’ Fede I o

Home __ SetupSpecs _Selup Project _ Analysis _ Rendom Sampling _ Navigation Tree_Reports Admi

Tools Navigate Help

o T MNavigation
ProjectName:  Clemson Bypass ltem Number poc TP - | Tone
P-401 . target value + tolerance Setup Specs
: ET Neww Project / Edi Mods
Project Number:  District-3-005-1 Ti
Characteristic: et o S e

03
T
| Lot Number | SampleNo. | Date: | TestResult | Contr/Owner | Lab Name | Tester 1D | Split Sample No. | Split Test Result| SplitLab Name

> BT S01C 10472007 586 Contractor  1-Contractor 3456 501S 56 1-District
B S0z 10142007 561 Contractor  1-Contractor 2456

RE 503 1042007 594 Contractor  1-Contractor 456

e S04 1042007 579 Contractor  1-Contractor 456

L2 01 1002007 578 Contractor  1-Contractor 3456

= S-02C 10//2007 565 Contractor  1-Contractor 3456 s2s 585 1-District
v 503 1082007 5.49 Contractor  1-Contractor 2456

e S04 1082007 549 Confractor  1-Contractor 2456

Lo soic 10222007 594 Contractor  1-Contractor M5 so1s 564 1-District
e 502 102212007 551 Contracter  1-Contractor 456

- |L-003 S03 10222007 5.85 Contractor  1-Contractor 3456

- [L-00e S01 11132007 535 Confractor  1-Contractor 3456

E S0z 11132007 5.7 Contracter  1-Contractor 456

mEn s03C 1MAY2007 547 Contractor  1-Contractor 3456 S8 569 1-District
mEN S04 11132007 586 Contractor  1-Contractor 456

| Loos 505 11n3z007 593 Contracter  1-Coniracior 2456

*

Figure 5.17 2

Working with Test Results

Once the project data have been entered using the Add Samples window they
can be edited and sorted in a number of ways.

Sorting the Data  Clicking the mouse on any column title causes the data to be sorted based on
that column. For example, in Figure 5.17, the test data for asphalt content are
sorted in increasing order by Lot Number. Clicking on the Lot Number
column title will cause the data to be sorted in decreasing order by Lot
Number.

Similarly, clicking on any other column title causes the data to be sorted by
increasing (or decreasing for a second click) order based on that column. For
example, clicking on Split Sample No. would bring all split sample results to
the top of the spreadsheet so they all could be viewed at once. Similarly, the
user might click on the Test Result column title to easily identify the lowest
and highest test values.
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Editing the Data  Figure 5.18 shows the drop down window that opens by right clicking
anywhere in the Add Samples window (see Figure 5.11). This window
provides the user a number of options for working with the test data. The
Delete Row and Delete Cell options are obvious. Clicking on these deletes
either the highlighted row or cell.

Printing the Data  Print Preview and Print Grid allow the user to preview a printout and to print
the spreadsheet for the characteristic that is currently displayed in the Add
Samples window.

Delete Row
Delete Cell

Import Data
Export Data

Print Preview

Print Grid

Analyze This Characteristic
Analyze This Item

Figure 5.18 Random Sampling

Analyzing the Data  The menu in Figure 5.18 allows the user to directly enter the Analysis
window with the analysis input already set to either Analyze This
Characteristic, e.g., Asphalt Content in Figure 5.17, or Analyze This ltem,
e.g., P-401 in Figure 5.17. The Analysis window is covered in detail in
Chapter 6. The user can consult Chapter 6 for detailed instructions on the
various analyses that can be performed on the item or characteristic.

Random Sampling  The menu in Figure 5.18 allows the user to directly enter the Random
Sampling window where sampling locations or times can be randomly
generated. The Random Sampling window is covered in detail in Chapter 7.
The user can consult Chapter 7 for detailed instructions on how to develop
random sampling locations or times.
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Figure 6.1

Selecting Data
for Analysis

Analyzing the Data

6 Analyzing the Data

The Analysis Window

The Analysis window can be reached by clicking on the Analysis icon at the
top of any screen and selecting New Analysis, or from the right click menu
on the Add Samples window (see Figures 5.11 and 5.18). The Analysis
window is shown in Figure 6.1. From this window the user can select a wide
range of projects and initiate any of the analyses of which PWLPay is
capable.

&l PWL Pay

File Tools Navigate Help

45 o = . 5 s
- " Fec?erul Highway
Home : ol . I @ Administration

Select a State / Agency Saved Data Analyses
South Carolina 5 ’—V| @ o
Contracts Not Added Contracts To Analyze Projects Not Added Projecis To Analyze

SC-2008-006

Select an ltem e
Select Analysis Type

Characteristics Not Added Characteristics To Analyze Select Output Type

ltems fo include:

PWL Format: PF Format:

The user has a wide array of options for selecting the data for analysis.

The user first makes a selection from the Select a State / Agency drop down
menu. In Figure 6.1, South Carolina has been selected. The Contracts Not
Added window automatically displays all contract numbers associated with
the selected state / agency. The user can then select Contracts To Analyze by
highlighting a contract number and clicking Add>>.

All projects associated with the contract numbers in the Contracts To
Analyze window are automatically displayed in the Projects Not Added
window. Once again, the Add>> button is used to select the Projects To
Analyze. All characteristics associated with the Projects To Analyze and the
selected item number are automatically displayed in the Characteristics Not
Added window. As before, clicking on Add>> selects the Characteristics To
Analyze. The user can select all characteristics for analysis with one click by
clicking on the Select All> button.
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Figure 6.2 shows that the data selected for analysis are from the state of
South Carolina, contract number SC-2008-001, project Clemson Bypass,
item P-401, and for the characteristics Asphalt Content, Air Voids, VMA, and
Density. Note that the Clemson Bypass Phase Il has not been selected and
therefore appears in the Projects Not Added window.

&l PWL Pay FEX

File Tools Navigate Help

E;f L L] aahil ;ﬁ @ " Federal H[gr':v.‘rcv .

Home __ Setup Specs _ Setup Project _ Analysis _ Random Sampling__ Navigation Tree __ Reporls @ Administration

Select a State / Agency Saver] Data Artlyses it

South Carolina o ’—v| @ T Data Analysis

Contracts Not Added Contracts To Analyze Projects Not Added Projects To Analyze

SC-2008-002 SC-2008-001

SC-2008-006

Select an ltem Options

BT Select Analysis Type
v

[ v

Characteristics Not Added Characteristics To Analyze
:} Asphalt Content

\?ITJITW liems fo include

Select Output Type

PWL Format: PF Format:

Why are some charscleristics not isted?

Figure 6.2 oo -

Types of Analysis

The analyses of which PWLPay is capable are identified in the Select
Analysis Type drop down menu in the Options section. Figure 6.3 shows the
possible analyses that PWLPay can perform. Each of these analyses is
described in detail in the following sections.

Options
Select Analysis Type

Descriptive Statistics
S4Tests for Normality
Process Control
Verification Tests

1t Pay Factors
Risk Analysis
PWL Format: PF Format:
Do Not Round Do Not Round

Figure 6.3
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Descriptive Statistics

After selecting Descriptive Statistics from the choices in Figure 6.3 the user
(essmmmssisssl|  then clicks the Begin Analysis >> button to perform the analysis and display
the results.

The Descriptive Statistics window is shown in Figure 6.4. General
informaton regarding the State / Agency and the Item Number: are displayed
at the top of the window. Click * on the Please select a test category: drop
down menu to display the options for which tests to analyze. The choices are
shown in Figure 6.5.

&l PWL Pay
File Todls

Navigate Help

LS w Uiyl g

Home  SetpSpecs Setup Project  Analysis  Rendom Sampling  Navigation Tree  Reports

Gy

State / Agency: South Carolina Please sslsct a test category: Total Statistics for charactenstic: Asphalt Cortent
Item Number: P-401 All Contractor Tests v Mean ‘570125 Skewness ‘4331545
NOTE: Graan esi diffe - Std_ Dev. }D 19435 Kurtosis ‘—1 29471
Summary Statistics ‘ Detailed Statistics ‘| Correlation Malrix‘
Airvoids | [Asphalt Content | Density | VMA |
Characlenstic Dala Analysis
| Contract No. | Project Name / Number | Lot Ne. | Sample size | Lot Mean |LotStdev. | ProjectMean | Project Stdev. | ContractM
> |SC2008-001  Clemson Bypess /District-3-0 L-001 4 52 014071 570125 013435 570125
= L-002 4 56025 0.14033
] L-003 3 576657 0.22679
| L-004 5 5662 024833
. < | >
Figure 6.4 _ _
Please select a test category:
All Contractor Tests “
All Contractor Tests
All Owner Tests
Contractor Tests without Splits
Independant Owner Tests
. 1Split Samples Onl
Figure 6.5 B B Y

Summary Statistics  As shown in Figure 6.4, the Summary Statistics displayed are for contract
number SC-2008-001 and the Clemson Bypass project. The mean and
standard deviation for Asphalt Content are shown for each lot on the project.
In addition, the total mean and standard deviation for all tests are shown in
the Project Mean and Project Stdev. columns. The Contract Mean and
Contract Stdev. columns display the results for all data on the contract. The
user must tab or scroll to the right to see the columns that are to the right of
the display area.

Note that summary statistics for Asphalt Content for all project data are also
shown in the upper right corner of the window in the section labeled Total
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Detailed Statistics

Analyzing the Data

Statistics for characteristic: Asphalt Content. The statistics shown are the
mean, standard deviation, skewness, and kurtosis. These are common
measures of probability distributions. These values are calculated using the
following formulas:

Mean: x==—
n
n ¥ 2
Standard Deviation: s = ZM
i=1 n _1
Skewness: g, = " Zn:(xi ~3)°
| b n-Dm-E s
n _7\4 _ 2
Kurtosis: g, - n(n+1) Z (x 4)c) _3(n-Y
(n-D)(n-2)(n-3)=F s (n—2)(n-3)
where: x = the sample mean,
X, = the individual values in the sample,
n = the number of values in the sample,
Ky = the sample standard deviation,
g = the sample skewness coefficient,
9, = the sample kurtosis coefficient.

The mean is a measure of the location of the data. The standard deviation is a
measure of the variability of the data. The skewness coefficient is a measure
of the degree of asymmetry of the data around the mean. A symmetric data
set has a skewness coefficient of 0. The kurtosis, which is a measure of the
“peakedness” or relative amount of data in the upper and lower tails of the
distribution of the data, is not often used.

PWLPay automatically checks the skewness and kurtosis values to see if they
could likely have come from a normal population. This check is conducted at
the significance level, alpha («), selected by the user. If the test on either the
skewness or kurtosis coefficient indicates that a normal population is
unlikely, the coefficient is shown in bold red print. Otherwise it is shown in

. A more detailed discussion of normality tests is presented
in Chapter 11.

The Detailed Statistics for the same project are shown in Figure 6.6. In this
case each individual test result is displayed on its own row along with its
corresponding lot and sample number. The Lot, Project, and Contract means
and standard deviations are shown as well. Some of these values are in
columns that are to the right of the display area and therefore the user must
tab or scroll to the right to see them.
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Figure 6.6

Correlation Matrix

Important Note on
Correlation

between
Characteristics

Analyzing the Data

&l pWL Pay ASE]
File

Tools Navigate Help

= » & T & @ o

Home  SetupSpecs  Setup Project  Analysis  Random Sampling _ Mavigation Tree  Reports

@ Administration

(\ Federal Highway .

State / Agency: South Carolina Please select a test category Lot S o et et Rtk Conterd
|
Jiem Number- P<401 All Contractor Tests v Mean 570125 Skewness |-03145
o i Std. Dev.. !D 19435 Kurtosis ‘-T 29421
| Summary Statistics | Detailed Statistics | Correlation Matrix|
AirVoids | [Asphall Gonient | Density” VMA |
Characleristic Data Analysis
Contract No. | Project Name / Number | Lot No. | Sample No. | Date |TestResult |LotMean  |LotSidev. | Froje
» |SC2008001  Clemson Bypass /District-3-0 L-001 S01C 101472007 586 58 0.12071 5701;
502 10/4/2007 561
03 10472007 53¢
S04 101472007 579
L-002 501 10/9/2007 5.78 5.6025 0.14033
S02C 105872007 565
503 105872007 549
504 10/9/2007 549
L-003 S01C 102272007 594 5.76667 022678
502 102212007 551
s03 102272007 585
L-004 501 1113/2007 5.35 5.662 0.24833
502 1111372007 57
s03C 111372007 547
504 1113/2007 5.86
505 111372007 593
& &

The correlation coefficient of two variables x and y, which is always between
-1 and 1, measures the linear relationship between x and y.

e Ifr=1(orr=-1), then x and y are strictly positively (or negatively)
linearly related, i.e., y is precisely some positive (negative) multiple
of x.

e Ifr=0,thenxand y are not linearly related. It does not mean that
they are not related. They could be related in some non-linear way.

e Ifr>0 (orr<0),then, when x increases, y tends to increase (or
decrease). The closer that r is to 1 (or 1), the stronger is the
correlation, as indicated by less spread in the data.

To be able to calculate a correlation coefficient between two variables there
must be a paired correspondence between the sample values. That is, for the
case of comparing the results of two different characteristics, the test results
must be obtained from the same sample.

For example, if asphalt content and VMA are both determined from the same
sample obtained at the plant, then there is a direct relationship between the
asphalt content and VMA test results for each sample number. Therefore, it
is appropriate to calculate a correlation coefficient between asphalt content
and VMA.

On the other hand, if density is determined by testing cores obtained from the
finished pavement, it is not possible to calculate a correlation coefficient
between laboratory-compacted air voids and density since there is no paired
correspondence between their test results.

A detailed discussion of correlation coefficients is presented in Chapter11.
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Figure 6.7 shows the Correlation Matrix screen for the Descriptive Statistics
analysis window. The second row of tabs now shows all of the possible pair-
wise comparisons among the characteristics for which test results are
available. In this case, there are six possible pair-wise comparisons for the
four characteristics.

&l PWL Pay

File Tools Navigate Help

EEJ L L LATE @ " Ee[derul H[ghwcﬁ;

Home  SetpSpecs SetupProject  Analysis  Rendom Sampling N Tree  Reports @ Administration
Stte [ Agency. Sauth Carling B Total Statitics for characteristic: Asphal Cortent

Item Number: P-401 All Contractor Tests v Mean ‘570125 Skewness ‘{\31545

Std_ Dev. }D 19435 Kurtosis ‘—1 29471

Summary Statistics W Detailed Slatrsligs‘ Correlation Matrix |
Correlation Grid | Air Voids & Asphalt Content ‘ Air Voids'& Density ‘ Asphalt Content & Density | Air Voids & VMA < »

Characteristic Correlation Matrix

Characteristic Asphalt Content Density VMA
Air Voids ’:ij‘_"“m :i 5 ::1\' S
Correlation Coeff: -0.05 Correlation Coeff:-0.35 Correlation Coeff: -0.36
Asphalt Content = 3\_}\% i 3\*‘\
=3 s s |
Correlation Coeff:-0.23 Correlation Coeff: -0.21
Density

= = o s
Correlation Coeff: 0.28

Save Correlation Matrix

Figure 6.7

Below this row of tabs is a matrix that shows all of the correlation
coefficients along with small versions of scatter plots of the two
characteristics showing the best straight line fit between the test results for
the two characteristics.

The user can save the correlation matrix to a CSV file by clicking
Save Correlation Matrix shown in the lower left corner of the screen in Figure
6.7.

The user can click on one of the tabs or on one of the plots to open a screen
with a large version of the scatter plot that shows the relationship between
the two characteristics. Figure 6.8 shows one of these screens for the Asphalt
Content & VMA comparison.

The user can click on '« > to scroll left or right to access all of the scatter
plots.

The best-fit straight line is also shown on the scatter plot. The correlation
coefficient and the equation for the fitted line are also shown. In Figure 6.8
these values are shown by Correlation Coeff (r): -0.21 and

Trendline Equation: y =-0.925054 x + 22.864589.
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Figure 6.8

Tests for Normality

Significance Level  Before beginning any normality testing the user should select the desired
level of significance, o, at which the test will be conducted. This can be done
from any screen by clicking on Tools in the upper left corner of the screen.
As shown in Figure 6.9, selecting Tools » Normality Check » Alpha Value
allows the user to select 0.01, 0.02, 0.03, 0.04, or 0.05 for the level of
significance. If the user does not select an alpha value, the default value of
0.05 is used.

& PWL Pay

File Tocls MNavigate Help

Database Options L A =
MNormality Check 4 v Show Mormality Chedk =
Hide Normality Check dom Sampling  Navig

Alpha Value »

Computation Routines »

v 0.05 (Default)

Figure 6.9

Checking Normality =~ PWLPay can be configured to automatically run a quick check for normality
in the Background  whenever new data are entered. This check is done in the “background” and

the user is notified only if the check indicates that there is a reason to believe
that the data are not from a normal population. The user can decide whether
or not to have PWLPay perform this background check by selecting Tools »
Normality Check. If Show Normality Check is checked, the automatic test is
performed. If Hide Normality Check is checked, the automatic test is not
performed. The user can at any time choose to test data for normality by
using the Analysis window.
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Run Test

Figure 6.10

Analyzing the Data

The quick background normality check tests at the selected alpha value
whether or not the skewness and kurtosis coefficients calculated for the test
data are unlikely to have been obtained from a normal population. When this
happens the warning window in Figure 6.10 is displayed and asks whether or
not the user wants more formal normality tests to be performed.

As shown in Figure 6.10, the warning message informs the user whether the
skewness and/or kurtosis values are questionable, and indicates at what alpha
value these coefficients were compared. The user selects whether or not to
run the normality test by selecting the Run Test or Don’t Run button.

Data Not Normally Distributed. Would you like to perform a Normality Test?
Caution: preliminary analysis indicates that the Asphalt Content's data may not be normally
distributed. Do you wish to conduct a formal test to assess the normality of these data?
Problem detected:

- Skewness of the Contractor’s Test Results
- Kurtosis of the Contractor's Test Results

This test was run with an alpha value of 0.05 (i.e. Z = 1.96). This value can be set by
going to Tools -> Normality Check -= Alpha Value.

Show this message next time

Don't Run ] l RLnTeﬂ.%

If Run Test is selected PWLPay performs two different checks for normality.
The fist is the Anderson-Darling (A-D) goodness of fit test specifically
modified to test for normality. This is a formal hypothesis test. Since this test
is quite sensitive to departures from normality, in PWLPay it is always
conducted at the 0.01 level of significance regardless of what value has been
selected with the Tools » Normality Check » Alpha Value option.

The second check for normality is to plot the data on a quantile-quantile plot
(qg-plot). Data that are normally distributed should approximate a straight
line on the qg-plot. This is, essentially, the same process as plotting the
cumulative distribution of the data on normal probability paper.

Detailed discussions of the Anderson-Darling test and gqg-plots are included
in Chapter 10.

Figure 6.11 shows the normality test results obtained if Run Test is selected
from the warning message in Figure 6.10. Note that the A-D indicates that
There is less than 1% chance that the data came from a normal distribution.
From the gg-plot it is easy to see why the A-D test for normality decalred the
data to be non-normal. One of the test results has been intentionally entered
as 20 rather than the correct value of 5.86.

PWLPay User’s Manual 6-8



Chapter 6

Figure 6.11

Tests for Normality

Figure 6.12

Analyzing the Data

Formal Data Test ®

Display test results for:

There is less than 1% chance that the data came from a
narmal distribution.

Anderson-Darling Test Result:

QQ Plot for Test Results

[rata from a nomal population should
approximate a striaght line on the qg-Flot

Close

After selecting Tests for Normality from the choices shown in Figure 6.3, the
user then selects the Begin Analysis >> button to perform tests for the
normality of the data and display the results. The Tests for Normality window
is shown in Figure 6.12. General informaton regarding the State / Agency
and the Item Number: are displayed at the top of the window. Click * on the
Please select a test category: drop down to display the options for which
tests to analyze.
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Split Samples Ont
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21 " Anderson-Darling Test Result:
There is not sufficient evidence to
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I .
Statistics
° ,
= Count: |16
@ .
=
S oA . Mean: 570125
~ Standard Deviation: [0.19435
L
- Anderson-Darling: (053791
14
: Skewness. |-0.31945
Kurtosis: |-1.29421
2 * NOTI hat th re
Test Result
Data fr | on the aa-Plot
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qqg-Plot

Anderson-Darling
Test

Figure 6.13

Skewness & Kurtosis

Figure 6.14

Analyzing the Data

Below the general information there is a row of tabs, one for each
characteristic. The Asphalt Content test results are displayed in the gg-plot in
Figure 6.12. The user must subjectively decide whether or not the data
approximate the straight line shown. If the answer is no, then the assumption
of normality is rejected.

The descriptive statistics and the results of the A-D test are shown to the
right of the gg-plot. The Count:, Mean:, and Standard Deviation: values are
obvious. The test statistic from the A-D test is shown in the Anderson-
Darling: box. This is for information only, and is unlikely to be of direct use
to the user. The conclusion to be drawn from the A-D test is shown in the
Anderson-Darling Test Result: box. No significant difference from a normal
distribution is reported as shown in Figure 6.13a, while a significant
difference from a normal distribution is reported as shown in Figure 6.13b.

Anderson-Darling Test Result: Anderson-Darling Test Result:
There is not sufficient evidence to There is less than 1% chance that the
conlcude that the data are not from a data came from a nommal distribution.
normal distribution.

(a) (b)

The Skewness: and Kurtosis: boxes are obvious. As in the Descriptive
Statistics window in Figure 6.8, the skewness and kurtosis coefficients are
checked at the selected significance level to see if they are different than those
expected for a normal distribution. No difference is depicted by

, While a difference is depicted by bold red print.

Process Control

After selecting Process Control from the choices in shown Figure 6.3, the
user must then select the types of process control charts to be developed as
well as how the control limits are to be established. Figure 6.14a shows the
types of charts that can be prepared and displayed as Output by PWLPay. If
one of the four control chart output options is selected, then the user must
also select the method to be used to establish the Control Limits for the
control charts. The two options are shown in Figure 6.14b.

Options Options

Select Analysis Type Select Analysis Type
Process Control B Process Control b
Output Output
| Control Charts for X-bar and R b
Control Charts for X-bar
Cicontrol Charts for X-bar and R Control Limits
Control Charts for Individuals K
Control Charts for Individuals and Rm
Run Chart \1Enter the Values
P P\calculate Values from Data
(a) (b)

PWLPay User’s Manual 6-10



Chapter 6 Analyzing the Data

Run Charts If Run Chart is selected as the Output, the user then selects the Begin
Analysis >> button to display the run charts for the selected characteristic(s).
(Bssnsmsisisss|  The Run Chart screen is shown in Figure 6.15. A run chart is a chronological
plot of the individual test results along with the specification limits for the
characteristic being plotted.
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Lot Number - Sample Number

Figure 6.15

At the top of the window is general information on the State / Agency:, the
Item Number:, and the Project Number:. There is also a drop down menu to
select which tests to analyze. Another drop down menu allows the projcect to
be selected. This choice will need to be made only if there is more than one
project selected in the Analysis window.

Below the general information there is a row of tabs, one for each
characteristic. The Air Voids test results are plotted in the run chart in Figure
6.15. Below the tabs is a description of the type of specification that applies
for the selected characteristic. PWLPay determines the target value, upper
specification limit, and lower specification limit based on the item number
and project that are selected.

The run chart plots the individual test results, which are identified on the
horizontal axis by their lot number-sample number combination. The dashed
line represents the mean of the test results.

The user can hover the mouse pointer over any of the lines or any of the data
points to open a bubble with appropriate detailed information. Examples of
these information bubbles are shown in Figures 6.16a — 6.16d, which
represent portions of the run chart in Figure 6.15.
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Figure 6.16

Control Charts

Begin Analysis ==

Control Limits
Based on the Data

Analyzing the Data
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(c) (d)

Figures 6.16a and 6.16b show that the target value is 4 and the upper limit is
5, respectively. Figure 6.16c shows that the data point is for Air Voids and
that it is #7 of 16 points that are plotted. The x and y coordinates for the point
are x = 6 (the plotting routine begins with 0, so the x value is one less than
the data point number) and y = 3.95 (which is the air voids test result). The
test result is for Sample Number S-03 within Lot Number L-002. Finally,
Figure 16.6d shows that the mean for all of the plotted test results is 4.56.

If one of the Control Chart outputs is selected (See Figure 6.14a) and
Calculate Values from Data is selected for establishing control limits, then
the user selects the Begin Analysis >> button to display the selected control
chart(s). PWLPay then calculates the target and standard deviation values for
all of the the selected test results (All Contractor Tests in Figure 6.15) and
uses these, along with the type of control chart selected, to determine the
control limits.

The Control Chart window, based on selecting Control Charts for X-Bar and
R and selecting Calculate Values from Data to determine the control limits, is
shown in Figure 6.17. The general information at the top of the window is the
same as for the Run Chart window. However, now there are two tabs for
each characteristic—one for the X-bar chart and one for the R chart. The user
can click on '« » to scroll left or right to access all of the tabs.

There are not as many points on the control chart since only one point is
plotted for each lot, as opposed to one point for each test for a run chart or
for a control chart for individuals. Similar to the Run Chart examples in
Figures 6.16a — 6.16d, more detailed information can be obtained by
hovering the mouse pointer over one of the lines or data points.
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&l PWL Pay
File Tools Navigate Help
2 A e . o - .
o &9 kD i s e
Home  SetupSpecs Sotup Project  Analysis _ Random Sampling _ Navigation Tree _ Reports

fi¥afi. o DR
" Fedel i
@ Administraf

State / Agency: South Carolina Please select a test category. Please select a Project Name:  Project Number:
E ‘ District-3-005-1

Item Number: P-401 ‘AH Confractor Tests vl |C\emsun Bypass

Control Charts for X-bar and R
m | Air Voids -R \ Asphalt Content - X-bar Asphalt Content - R ‘ Density - X-bar ‘ Density - R ‘ VM ¢« »
Spec Type: Target Value + Tolerance
Process Control Chart for: Air Voids

511
o S
497
487
2477
S 46+
el
447
43—
421 IS
417
T T 1
iﬁol (;goe (*00_? 4‘004

Lot Number

Figure 6.17

One difference between a run chart and a control chart is that the run chart
compares the data points to the specification limits, whereas for a control
chart the limits are established based on the mean and variability of the
process, i.e., the population of avaiable test results. Note in Figure 6.17 that
the control limits are not necessarily horizontal lines. Control limits depend
upon the sample size for which the mean is determined. If the sample size is
constant, the control limits will be constant horizontal lines. However, if the
sample size varies between lots, the control limits will expand for smaller
sample sizes and shrink for larger sample sizes.

If individual tests, rather than lot means and ranges, are plotted, then the
moving range, Rm, is used to control variability. In this case, the first point
on the moving range chart will lag by one the first point on the control chart
for individuals. Figure 6.18 shows a sample control chart for individuals.
While this chart may appear similar to the run chart in Figure 6.15, the
control limits in Figure 6.18 are determined from the process capability and
differ considerably from the specification limits plotted in Figure 6.15.

Control Limits  The user can choose to enter the target values and control limits rather than
Entered by User  to have PWLPay calculate the limits from the input data. This might be done
if the user had a continuous and stable process for which the limits had been
established from a large amount of historical data. Since these entered
control limits will be constant, this implies that the sample sizes will be the
same for all or nearly all lots.
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Figure 6.18 I

Figure 6.19 shows the selections that would be made to plot control charts for
individuals and for moving ranges when the target values and control limits
will be input by the user. At this point the user selects Begin Analysis >> to

[ Begin Anslysis > | open the window shown in Figure 6.20, which then results in the moving
range chart shown in Figure 6.21.

Options
Select Analysis Type

| Process Control - |

Output
| Control Charts for Individuals and Rm V|

Control Limits

PWL Format: PF Format:
Do Not Round Do Not Round

Do not include Infermation On: ¥ CNaraciensucs n uns report

Figure 6.19

A thorough description of control chart analysis is provided in the ASTM
Reference publication Presentation of Data and Control Chart Analysis, Seventh
Edition, February 2002, which is available at www.ASTM.org.
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Figure 6.21

Verification Tests

Verification tests are performed to compare two sets of test results to
determine whether or not it is reasonable to assume that they came from
similar populations. To make this comparison it is necessary to run statistical
tests to see whether or not it is reasonable to assume that both their means
and variances (variance is the square of the standard deviation) are equal.

The #-test is used to compare the sample means of the two sets of test results,
while the F-test is used to compare their variances. Which form of the #-test
to use depends upon whether the data to be compared are from split samples
or independent samples. If the data are from split samples, then the paired ¢-
test is used. If the data are from independent samples, then the two-sample ¢
test is used. The same F-test is used for both split or independent samples.
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Figure 6.22

Comparing
Split Samples

Figure 6.23

Begin Analysis >

Analyzing the Data

Thorough descriptions and discussion of #-tests and F-tests are available from
numerous statistical texts and websites. The use of these tests for highway
materials and construction is presented in Optimal Procedures for Quality
Assurance Specificatons, Publication No. FHWA-RD-02-095, April 2003.

After selecting Verification Tests from the choices shown in Figure 6.3, the
user must then select the tests that are to be compared. The Compare drop
down menu in Figure 6.22 shows the types of comparisons that can be
performed by PWLPay. The choice of which tests to use for the comparisons
dictates the options from which the user selects in the Which tests do you
wish to run? drop down menu since different tests are performed depending
upon whether the data to be compared are from split samples or independent
samples.

Options
Select Analysis Type

Verification Tests -

Compare

Split Samples

Contractor's indpnt ws, owner's indpnt
Contractor's indpnt ws. owner's split samples
All contractor tests vs. owner's indpnt
Contractor's indpnt ws. all ownet's

If Split Samples is selected as the Compare option, then the user must select
from the comparison test options shown in Figure 6.23. With split samples
where the split results make up sample pairs, the paired ¢-test is preferable to
the two-sample #-test, and thus only the paired ¢-test is available for selection.

Options
Select Analysis Type

Verification Tesis b
Compare
Split Samples v

Which tests do you wish to run?

1. Paired t-test for equal means
2. F-test for equal variances
1.and 2.

L =z7¢

The user can choose to run only the paired ¢-test to compare sample means,
only the F-test to compare sample variances, or both tests. The choice will
obviously affect the calculations performed and the resulting output. After
making this choice the user selects Begin Analysis >> to perform the
verification tests.

Figure 6.24 shows an example of the output if the user has selected to run
both the paired #-test and the F-test. The #-test output shows the sample
means, sample standard deviations, and sample sizes along with the P-Value
for the test statistic. The P-Value is the probability of getting a test statistic
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greater than or equal to the one obtained if the two samples came from the
same population, i.e., if the two population means were actually equal.
Therefore, the smaller the P-Value the less likely the sample means are
equal. PWLPay displays a warning message when the means are statistically
significantly different at the 0.10, 0.05, or 0.01 levels. This corresponds to P-
Values less than 0.10, 0.05, or 0.01, respectively.

& pPWL Pay
File Tools Navigate Help

oo 0 S e

Home _ SetupSpecs SetupProject  Analysis _ Random Sampling _ Navigation Tree __Reports

ArVoids || Asphak Cortert. | Densty ‘ VMA
Split Samples
Split Samples: Paired test for equal means
Owner Contractor
Mean 5645 573
Standard Dev. 0.03697 021213
Observations 4 4
df &
P-Value 0.5345
Split Samples: F-test for equal variances
Owner Contracior
Mean 5.645 573
Variance 0.00137 0.045
Observations 4 4
df 2 2
P-Value 0.00851
Figu re 6 24 Significantly different at the 0.01 level.
.

The F-test output (See Figure 6.24) shows the sample means, sample
variances, and sample sizes along with the P-Value for the test statistic. As
with the #-test, PWLPay shows a warning message when the P-Value is less
than 0.10, 0.05, or 0.01. In Figure 6.24, the variances are shown to be
Significantly different at the 0.01 level.

Comparing  The user has four different independent sample comparisons in the Compare
Independent Samples  drop down menu shown in Figure 6.22. These comparisons are:

Contractor’s indpnt vs. owner’s indpnt. This would apply in a situation
where the contractor was performing acceptance testing for the project, and
the owner was also obtaining and testing its own samples from different
random sampling locations than those used by the contractor.

Contractor’s indpnt vs. owner’s split samples. This would apply in a
situation where the contractor was performing acceptance testing for the
project, but a portion of the samples were split and tested by both the
contractor and the owner. In this case the contractor samples that were not
split would be independent samples that could be compared with the owner
tests on the split samples. The contractor’s test results on its portion of the
split samples would not be included in this comparison.

PWLPay User’s Manual 6-17



Chapter 6 Analyzing the Data

All Contractor tests vs. owner’s indpnt. This would apply in the event that
the contractor was performing the acceptance testing and some of the
contractor’s samples were split and tested by the owner. However, the owner
was also obtaining and testing samples from sample locations that were
independent of those used by the contractor. In this case the owner’s
independent samples could be compared with all of the contractor’s samples,
including the contractor’s portion of any split samples.

Contractor’s indpnt vs. all owner’s. This would apply in the event that the
contractor was performing the acceptance testing and some of the
contractor’s samples were split and tested by the owner. However, the owner
was obtaining and testing samples from sample locations that were
independent from those used by the contractor. In this case the contractor’s
independent samples could be compared with all of the owner’s samples,
including the owner’s portion of any split samples.

If any of these independent comparison options is selected, then the user
must select from the comparison test options shown in Figure 6.25. Since the
samples to be compared are independent, the two-sample #-test is performed
and the paired z-test is not an option.

Options
Select Analysis Type

Verification Tests -

Compare

Contractor's indpnt vs. owner's indpnt b

Which tests do you wish to run?

v

t-test for equal mean (unequal variances)
F-test for equal variances

t-test for equal means (equal variances)
F-test then appropriate resulting t-test

Figure 6.25

As shown in Figure 6.25, the user can select to run only the #-test. The s-test
is conducted differently whether or not it is assumed that the sample
variances are equal, which is why in Figure 6.25 there are two choices for
running the z-test. The user can also select to run only the F-test. It is most
likely that the user would select the last option to run the F-test then
appropriate resulting t-test. In this case the user enters the level of
significance, alpha, at which to run the F-test (see Figure 6.26). PWLPay runs
the F-test then, depending upon the result, runs either the ¢-test for equal

Begin Analysis >> variances or the r-test for unequal variances. After selecting one of the
options shown in Figure 25, the user selects Begin Analysis >> to perform the
verification tests.

Alpha Input Form
Please enter an alpha value for the F-test

0.05

Cancel ] [ Continue

Figure 6.26
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Figure 6.27 shows an example of the output if the user had selected the F-test
then appropriate resulting t-test option for comparing the Contractor’s indpnt
vs. owner’s split samples for the characteristic Asphalt Content. The F-test
output shows the sample means, sample variances, and sample sizes along
with the P-Value for the test statistic. It also shows the entered alpha value
(alpha = 0.05 in Figure 6.26). PWLPay shows a warning message if the
variances are significantly different at the entered alpha value. In Figure 6.27,
the variances are shown to be Significantly different at the 0.05 level.

The results of the ¢-test are shown to the right of the F-test results. PWLPay
automatically performs the correct #-test based on the results of the F-test,
and reports the P-value. In Figure 6.27 the F-test found the variances to be
unequal at the specified alpha value. So, the results are reported for the ¢-7est
Assuming Unequal Variances.

&l PWL Pay

File Tools Navigate Help
Sts . e == e

= : L i o e

Home __Sefup Sefup Project__ Analysis __ Random Sampling _ Navigalion Tree__ Reporis

Aopha Contert | Densty | VA

e idm

Contractor Independent vs. Owner's Split Samples

Independent Samples: F-test then appropriate resulting t-test

Owner Conftracior
Mean 5.645 56917
Variance 0.00137 0.03883
Observations 4 12 tTest Assuming Unegual Variances
df 12 mn 12!
P-Value 0.0187 045039
Significantly different at the 0.05 level. alpha = 0.05

Save As
Open with Excel

Figure 6.27

Saving Verification  Right clicking anywhere in the results area of the verification test report
Test Results  opens the popup menu shown in Figure 6.27. Selecting Save As saves the
verification test results as a CSV file in the same format as shown on the
screen. The user can also select Open with Excel to open the CSV file in
Excel if it is available on the user’s computer.

Pay Factors

The Pay Factors option is used to calculate and report the payment factors
for both the individual characteristics and the composite lot payment factor.
PWLPay uses the payment relationships that were entered in the Setup Specs
window and the specification limits that were entered in the Setup Project
window to determine the payment factors.
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Figure 6.28

Which Tests to Use

Rounding Format

Analyzing the Data

After selecting Pay Factors from the choices in Figure 6.3 the Output drop
down menu is used to select whether a detailed payment report or just a
summary report should be prepared. The Use drop down menu then allows
the selection of which tests to use to determine the payment factors. The
options for which tests to use to determine payment are shown in Figure
6.28.

Options
Select Analysis Type

Pay Factors v
Output

Detailed Report -
Use

v

only confractor tests

only independent owner tests

both contractor and independent owner tests | .,

only owner split tests

only all owner tests rt

The options for which tests to use include:

only contractor tests. This might be chosen if the contractor is performing
the acceptance tests and the tests have been verified by owner tests.

only independent owner tests. This might be chosen if the owner is
performing the acceptance tests.

both contractor and independent owner tests. This might be chosen if the
contractor is performing the acceptance tests and the tests have been verified
by independent owner tests. It is not recommended that contractor and owner
tests be combined even if both their means and variances have not been
declared different in the verification testing. This is because the verification
tests do not prove that the two samples are exactly equal, and it is likely that
combining the two samples will lead to increased variability.

only owner split tests. This might be chosen if the contractor is performing
the acceptance tests and the owner is using split samples for verification
testing. If the tests do not verify, then the owner may decide to use its tests,
rather than the contractor’s, to calculate the payment factors.

only all owner tests. This might be selected if the contractor is performing
the acceptance tests and the owner is using both split samples and
independent samples for verification tests. If the tests do not verify, then the
owner may decide to use all of its tests to calculate the payment factors.

Since owners use different rounding rules when calculating payment factors,
PWLPay requires the user to specify the rounding procedures to use before
payment factor calculations can begin. Rounding can apply to either the
calculated PWL values that are used in the payment factor calculations, to the
payment factors that have been calculated, or to both. So, the user must
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choose from the rounding methods shown in Figure 6.29 for both the
PWL Format and the PF Format.

Select Analysis Type

Pay Factors v
Output

Detailed Report v
Use

only coniractor tests v
PWL Format: PF Format

Do Not Round V Do Not Round b

Do Not Round
Round to Nearest Integer It

Always Round Down

Figu re 6 29 Always Round Up Bis =>

The PWL rounding format is applied to the PWL values that are input into
the payment relationship to calculate the payment factors. The PF rounding
format is then applied to the calculated payment factors. The rounding format
options include:

Do Not Round. This is the default option. No rounding is used for the
calculated values.

Round to Nearest Integer. If chosen, the PWL value is rounded to the
nearest integer before it is input to the payment relationship. If chosen, the
calculated payment factor is rounded to the nearest integer.

Always Round Up. If chosen, the PWL value is always rounded up to the
next higher integer before it is input to the payment relationship. For
example, a value of 94.02 would be rounded to 95. If chosen, the calculated
payment factor is always rounded up to the next integer.

Always Round Down. [f chosen, the PWL value is always rounded down to
the previous lower integer before it is input to the payment relationship. For
example, a value of 94.82 would be rounded to 94. If chosen, the calculated
payment factor is always rounded down to the next integer.

Emnimanses|  After making this choice the user selects Begin Analysis >> to calculate and
report the payment factors.

Detailed Report  Figure 6.30 shows an example detailed payment report. The title shows that
the user had selected a Detailed Report and that payment factors be
calculated using Only Contractor Tests. The report includes the Project
Name, Project Number, Lot Number, Characteristic, Sample No., Date, and
the Test Result. The full report does not fit in the viewing window; the user
must scroll the screen to the right to see the payment information.
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Pay Factors Based On - Only Contractor Tests [Detailed Report]

Test categary. ‘Onry Contractor Tests N
[ sc20000 -pa01.
Project Name | Project Mumber Lot Number Characteristic | Sample No. | Date Test Result | Sample Size Mean Standard De
> District-3-005-1 | L-001 Air Voids s01C 10/4/2007 |49 4 4.3025 021313
502 10/4/2007 |4.23
503 10/4/2007 |47
504 10/4/2007 |462
Asphalt Cortert | S-01C 10/4/2007 |5.86 4 58 0.14071
50z 10/4/2007 |5.61
503 10/4/2007 |5.94
504 10/4/2007 |5.79
Density s01C 10/4/2007 (842 12 834 0.24531
502 10/4/2007 (928
503 10/4/2007 |93.2
504 10/4/2007 |936
505 10/5/2007 |94
506 10/5/2007 |91.8
s07 10/5/2007 |926
508 10/5/2007 (928
509 10/8/2007 |93.2
510 10/8/2007 (934
s-11C 10/8/2007 |94.4
512 10/8/2007 |94.7
VMA s01C 10/4/2007 1722 4 176175 0.34731
502 104472007 |17.51
503 10/4/2007 |18.05 i
Figure 6.30 < 2

Summary Report  Figure 6.31 shows an example summary payment report that would
accompany the detailed report shown in Figure 6.30. The same columns that
appear in the Detailed Report appear in the Summary Report. However, in
the Summary Report, only sample sizes, lot means, and lot standard
deviations are displayed. The individual test results do not appear in the
report.

Pay Factors Based On - Only Contracior Tesis [Summary Repord]

Test category: | Only Cortractor Tests v
SC-2008-001 - P401
Project Name | Project Number = Lot Number | Characteristic ~ Sample Size Mean Standard Dev | PWL Pay Adjustment s
» District 30051 | L001 Air Voids 4 43025 021313 100 105
Asphalt Corttert |4 5.8 0.14071 97.37794 103.68857
Density 12 534 0.84531 95.8994 102.71375
VMA 4 176175 0.34731 100 105
Composite Type: | Weighted Average Composite PF = | 103.7577:
Clemson Bypass | District-3-005-1 | L-002 Air Voids 4 42675 0.22692 100 105
Asphalt Cortert |4 5.6025 0.14033 5810193 104.05097
Density g 53.875 0.69437 100 103.26
VMA 4 18.0325 0.38187 100 105
Composite Type: | Weighted Average Composite PF = | 104.06674
Clemson Bypass | District-3-005-1 | L-003 Air Voids 3 45467 0.33531 100 105
Asphalt Cortert |3 5.7667 0.22679 85.0006 57.5003
Density €& 53.35 0.88713 95.55458 10263716
VMA 3 17.0267 144154 60.24751 86.12375
Composite Type: | Weighted Average Composite PF = | 100.19231
Clemson Bypass | District-3-005-1 | L-004 Air Voids 5 5.006 0.10139 47.85438 44 34157
Asphalt Cortert |5 5.662 0.24833 78477 54.22872
Density 10 53.16 0.71056 95.85183 102.70347
VMA 5 17.554 1.00269 86.1283 57.56415
Composite Type: | Weighted Average Composite PF = | 85.48287
Figure 6.31 L
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Saving the Pay  Right clicking anywhere in the spreadsheet area of either payment report

Factors Report  opens the popup menu shown in Figure 6.32. The user can choose to open the
report with Excel, if it is available on the user’s computer, or to save the
payment report as a CSV file. The user has three options regarding saving the
CSV file. Two of the options relate to the format in which the data are stored
in the CSV file. The third option brings up the message in Figure 6.33, which
explains the two different formats.

&l PWL Pay

File Tools Navigate Help

X : = 2.
= 0w LT G - e
Home  SetupSpecs  Setup Project  Analysis  Random Sampling b Tree  Reporis @ Administration
Pay Faclors Based On - Only Contracior Tests [Summary Reporl]

Test category: | Only Contractor Tests v

5C-2008-001 - P-401 !

[ Project Name | Project Number | Lot Number | Characteristic | Sample Sze | Mean ‘Standard Dev | PWL Pay Adjustment
3 L1001 Air Voids 4 43025 jozms |0 105
Asphalt Cortent |4 58 Save Dats (Default) 103.68897
Derdly, 12 B4 Save Data without Quotes 7137
VA 4 17675 N o 105
Composts Typs: Weights| | | 1037571
Open with Excel S
Clemson Bypass | District-3-005-1 | L-002 Bir Voids 4 42675 022652 100 105
Asphalt Content |4 56025 0.14033 9810193 104 05097
Density 8 93875 069437 100 10326
VA 4 18,0925 0187 |10 105
Compasts Typs: Weighted Averags Compasts PF - | 104.06674
Clemson Bypass | District-3-005-1 | L-003 Air Voids 3 45467 033531 100 105
Asphalt Cortent | 3 57667 022679 85.0006 §7.5003
Density 6 9335 0388713 9555458 10263716
VA 3 17.0267 144154 0M7TH | 8512375
Compasts Typs: Weighted Averags Compasts PF - | 10019231
Clemson Bypass | District-3-005-1 | L-004 Bir Voids % 5.006 0.1013% 4789438 4434157
Asphalt Content | 5 5662 024833 784744 94 23872
Density 10 9316 071056 9585183 10270347
VA 5 17554 100269 851283 9756415
. Compasts Typs: Weighted Averags Compasts PF - | 8548287
Figure 6.32
Export Options X

the databage For Descriptive Statistics, Excel trims leading zeros off of data in CSY format, i.e., Lok Number: '001" would be displayed as '1'in Excel. To
preserve data integrity, Lat Number: 001 can be exported as ="001",

i J when opening a CSY file, data integrity is not always preserved in Excel, With PWL Pay, vou have twa different options For exporting the data from
This may cause problems when importing data back into other software programs s the option to not include quotes has also been added.
The Default option only adds quotes to non-numeric fields (i.e., not the Test Result or Date fislds),

These export options are important when the user wants to change data in Excel. This preserves data integrity so that Lot Mumber: 001 samples are
not placed into Lok Mumber: 1.

MOTE: PWL Pay will recognize data that have been exported and automatically remove the Formatting characters,

Figure 6.33

As discussed in Chapter 5, always including a letter in lot and sample
numbers will avoid the potential formatting problems that are explained in
Figure 6.33.

Risk Analysis

Risk Analysis allows the user to ask and answer “what-if” questions about the
potential effects of either making or not making changes in their production
processes. After selecting Risk Analysis from the choices in Figure 6.3, the
user must then select one of the two options from the Calculate drop down
menu shown in Figure 6.34a. Next, the user selects whether to Use “to-date”
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Figure 6.34

Projected Pay
Factor

Begin Analysis =»

Analyzing the Data

means and standard deviations from existing test results, or to enter directly
the means and standard deviations to use in the analysis (see Figure 6.34b).
The “to-date” values would be used if the user wishes to know what will
happen if the process remains in its current state. The user would choose to
enter new values if a process change is being considered.

Options Options

Select Analysis Type Select Analysis Type
Risk Analysis - Risk Analysis -
Calculate Calculate
e Projected Pay Factor v
Projected Pay Factar
Long Term Expecied Payment Use
-
. . Use "to-date" means & std devs v?
FWL Format: PF Format: Input the means & std devs
Do Mot Round A Do Mot Round ¥ Do Mot Round A Do Mot Round ¥

[] Do not include Information Only characteristics in this report [] Do not include Information Only characteristics in this report

(a) (b)
The Projected Pay Factor in Figure 6.34 is the payment that the contractor
would be expected to receive for the project if it achieved the means and
standard deviations used in the analysis. This value is particularly important
in cases where the entire project is the payment lot, and the contractor wishes
to project what its likely payment will be for the total project.

While likely less important in cases where the payment lot is a day’s
production, Projected Pay Factor can still be used to determine likely
individual lot pay factors for selected process means and standard deviations.
For example, if a contractor has received reduced payments for lots early in a
project, this analysis could be used to investigate what changes in means
and/or standard deviations would be necessary to receive full payment or an
incentive payment for future lots.

After selecting the option from the Use drop down menu shown in Figure
6.34b, the user selects Begin Analysis >> to calculate and report the projected
payment factors. What happens next depends upon which selection was made
in the Use menu.

Use “to-date” means & std devs. If the user selected to use means and
standard deviations calculated from the current test data, the window in
Figure 6.35 is displayed. The user then enters the projected sample size for
each characteristic shown. This will usually be the sample size that is
anticipated at the end of the project. After entering the desired sample sizes,
the user selects Continue to generate the Projected Pay Factors report shown
in Figure 6.36.
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Risk Analysis 3]

Pleass enter the follawing projected values

Sample Sizes teans Std Devs

Ajroids ‘40

Asphalt Content ‘40

WA, ‘40

|
|
Density ‘BU |
|
|

Characteristic ‘

Figure 6.35

& PWL Pay

@ Q }:ea‘el HIghwéE

= Reports Administration
ests [Summary R eport]

Test category: | Only Contiactor Tests o

5C-2008-001 - P-401

| Project Name  Project Nurber | Characteristic | SampleSize  Mean Stardard Dev | Pl Pay Adiustment
S Distict 30051 Air Voids 40 45534 037341 |B7TTAG | 9777454
| Asphal Content 40 57012 01435 B0 |S9.0%7
[Dersty |60 924308 oMz s 10284603
Tma T 17,5308 ossss snanr 1001214
| | Composte Type: Weighted Average | Projected PF = | 1003534
Figure 6.36 gl | \

As shown in Figure 6.36, the Projected Pay Factors report shows the
contract number, SC-2008-001, and item number, P-401, at the top left just
above the spreadsheet section. Additional project information as well as the
projected PWL and payment values is presented in the spreadsheet section.
For example, in Figure 6.36, for Air Voids the mean and standard deviation
calculated from the “to-date” data are 4.5594 and 0.37941, respectively.

This information, along with the projected sample size of 40, results in a
projected Air Voids PWL of 87.77454 with a resulting projected pay factor of
97.77454. The composite pay factor, based on the Weighted Average
approach, for the lot is projected to be 100.3534. As with other screens in
PWLPay, right clicking in the spreadsheet window shown in Figure 6.36
allows the user to save the report in CSV file format or open it with Excel.

The Test category drop down menu shown in the upper right corner of Figure
6.36 allows the user to select which tests should be used to determine the “to-
date” values for mean and standard deviation. In Figure 6.36, Only
Contractor Tests is selected. Figure 6.37 shows the test categories from
which the user may choose.

Test category: | Only Conltractar Tests

Only Contractor Tests
Oty Dwiner Independent Tests
Bath contractar and independent awner te

m Oy owner split tests
Figure 6.37 Only owner bests
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Figure 6.38

Figure 6.39

Long Term
Expected Payment

Analyzing the Data

Input the means & std devs. [f the user selects to input hypothetical means
and standard deviations, the window in Figure 6.38 is displayed. The user
then enters the projected sample size, mean, and standard deviation for each
characteristic shown. After entering the values, the user selects Continue to
generate the Projected Pay Factors report shown in Figure 6.39.

Please enter the following projected values
Sample Sizes Means Std Devs
AirVoids 40 4.1 05
Asphalt Content 40 5.6 02
Deensity G0 96.0 08
Ve 40 180 0.75
Characteristic

Projected Pay Factors Based On - Only Contractor T ests [Summary Repot]
Test categary: Only Contractor Tests v

5C-2008-001 - P-401

Project Mame Project Mumber ~ Characteristic | Sample Size Mean Standard Dev | PwlL Pay Adjustment
Cl =Y District-3-005-1 | Air Vaids 40 41 05 95.42817 10271409

Asphalt Content | 40 56 0.2 82.06999 96.035

Density &0 96 0.8 73.34482 6768526

WA 40 18 075 97.94143 103.97071
Composite Type: | Weighted Average Projected PF = | 9515845

The Long Term Expected Payment shown in Figure 6.34a is the payment
that the contractor would be expected to receive on the average for a very
large number of lots with the stated means and standard deviations for each
characteristic. In other words, it is the “average payment in the long run.”
This gives the contractor an idea of the payment it can expect to receive if it
maintains production at the current, or at a hypothetical, process capability.
This can help the contractor decide how best to set the target values and how
much process control is needed for each characteristic that will be measured
for payment.

After selecting the Long Term Expected Payment option shown in Figure
6.34a, the user selects Begin Analysis >> to open the window shown in
Figure 6.40. The user enters the sample size, mean, and standard deviation
for each characteristic shown.
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Please enter the following values
Number of iterations {10000 {integer less than or egual to 100,000)
Sample Sizes Means Std Devs Independent Correlated

Air Voids 5 4'\ U5 ‘@) ®

Asphalt Content :5 58 o2 ®

Density 8 . 196 .U.S (O] O

mA s | e [o7s o ®

Characteristic .

Cancel I [ Continue ]
Figure 6.40
Note in Figure 6.40 that the characteristics can be checked as either
Independent or Correlated. As discussed above in this chapter, to be able to
calculate a correlation coefficient between two variables there must be a
paired correspondence between the sample values. That is, for the case of
comparing the results of different characteristics, the test results must be
obtained from the same sample.
Since this is the case, all correlated characteristics checked in Figure 6.40
must have the same sample size. PWLPay checks to see if this is true, and if
not, issues the warning shown in Figure 6.41. Independent characteristics can
have different samples sizes per lot.
Sample Sizes Differ
A All of the correlated characteristics do not have the same number of samples:
* : :2;;?3‘ ;jtscr;?'vznstirgzliséamples L
- WMA has 5 samples.
.
Figure 6.41

Since the Long Term Expected Payment analysis uses computer simulation
to determine the expected payment, the user also must enter the Number of
iterations (i.e., the number of lots to be simulated) as an integer less than or

equal to 100,000. Selecting Continue begins the simulation process and, if
any correlated characteristics are involved, pops up the screen shown in
Figure 6.42 where the user enters the correlation coefficients for the
correlated characteristics.

PWLPay checks the entered coefficients and if they are not consistent with
one another issues the warning shown in Figure 6.43.
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Figure 6.42

Figure 6.43

Figure 6.44

PWLPay User’s Manual

Analyzing the Data

Risk Analysis - Correlated 3]

Enter the correlation coefficients between each pair of characteristics:

Characteristic Asphalt Content  WVMA

Air Voids |’D-5 | |D'75 ‘ | | | ‘

s | L]

Asphalt Conte.

[ Cancel [ Continue J

Iconsistent Coefficients

' This combination of coeffidents is not consistent, Please change the coefficents.
LAY

Figure 6.44 shows the results screen that is displayed when the simulation
analysis from Figures 6.40 and 6.42 is completed. General information to
identify the simulation is shown at the top of the display window.

2 PWL Pay

File Todls Navigate Help
X : > 2 (550 il

) v L 1] Sfs 2 ' Federa

Home  SetupSpecs  Setup Project  Analysis  Random Sampling  Navigaion Tree  Reports @ Administratiol

Contract Number: SC-2008-001

State / Agency: South Carolina Project Name: Clemson Bypass

Home
Data Analysis

Item Number: P-401 Long Tem Exp. Pay Factor

Project Number: District-3-005-1

#irVoids | [ Agphalt Contert] | VMA | Density | Composie (Lot) |

Histogram of Individual Pay Factors

600 -
Statistics

550 -]

0] Number of Iterations: | 10,000

450 ]

p— Pay Factor Resulis

e Mean: (9593305

Standard Deviation: [57611‘5597
Skewness: ﬁaﬁ@ﬁi
5th Percentile: |26.29

95th Percentile: (10452

200 4
150
100
504
0= T

75 80 a5 %0
Histogram Bins:

Individual Pay Factors

The user can select one of the tabs to display the histogram of the distribution
of the pay factors for the number of simulated lots (10,000 in Figure 6.44) for
each characteristic (Asphalt Content is selected in Figure 6.44) or for the
Composite (Lot) pay factor. The Histogram Bins: section in the lower left
corner allows the user to select the number of bars (i.e., bins) to use when
plotting the histogram. The default value is 100, but a value of 50 has been
entered in Figure 6.44.
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The Statistics section displays a number of descriptive statistics for the
selected tab. The Number of Iterations:, Mean:, Standard Deviation:, and
Skewness: values are obvious. The 5th Percentile: shows the pay factor
value for which 5% of the simulated pay factors were less than or equal. The
95th Percentile: shows the pay factor value for which 95% of the simulated
pay factors were less than or equal.

Figure 6.45 displays the simulation results for the Composite (Lot) pay factor
for the same simulation shown in Figure 6.44. The Mean: value indicates that
the contractor can expect a long term average pay factor of 93.73 percent if
its process has the values shown in Figures 6.40 and 6.42.

& PWL Pay

File Tools Navigate Help
il . - .
o kY LU e e

Home  Setup Specs _ Selup Project _ Analysis _ Random Sampling _ Navigation Tree__Reports '.“Admlmslraﬂon

State / Agency: South Carolina Ceontract Number: SC-2008-001 Project Name: Clemson Bypass
ltem Number: P-401 Project Number: District-2-005-1 b o
AirVoids | Asphal Cortent | VMA | Densiy iiumpos«e (Lot} |
Histogram of Individual Pay Factors

550 =
Statistics

500 ———
Number of Iterations: | 10,000

450 4

400 4
Pay Factor Resulis

350 e

Mean: 9373024

300 4

- Standard Deviation: |6.06005

200 Skewness: i«ﬁ’é@éﬁ]@i

(ol 5th Percentile: [81.69

100 S

. 95th Percentile: |101.72
04
70 75 80 2 %0 %5 100 105
Histogram Bins: >0 :
Individual Pay Factors
Figure 6.45

Due to the random nature of the computer simulation process that is used in

Computer the Long Term Expected Payment analysis, the results of each analysis will
Simulation Results vary slightly for identical input values. This is the case whenever computer
simulation is used.

Important Note on

Thorough descriptions and discussion of computer simulation for risk
analysis are well beyond the scope of this user’s manual. Discussion of the
evaluation of risks for highway materials and construction is presented in
Reference detail in Optimal Procedures for Quality Assurance Specificatons,
Publication No. FHWA-RD-02-095, April 2003.

Saving an Analysis

When working on a project, as new test results become available it is likely
that the user will perform the same analyses on a routine basis. To speed up
these repetitive analyses, the user can save an analysis, which allows the user
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| Begin Analysis >> |

[ Save thiz Analyziz ]

Figure 6.46

Figure 6.47

Working with
Saved Analyses

Figure 6.48

PWLPay User’s Manual

Analyzing the Data

to bypass many of the selection menus associated with some types of
analysis.

The screen shown in Figure 6.46 shows a Descriptive Statistics analysis that
is ready to be initiated by selecting Begin Analysis >>. Before beginning the
analysis the user can click on Save this Analysis to open the window shown
in Figure 6.47. The user then enters an easily recognizable name that
describes the analysis (Clemson Bypass - Desc Stat in Figure 6.47).

& PWL Pay
File

Took Navigale  Help

LI

Selup Project

N Fecoia

¥
'w Administrafion

Select a State / Agency

South Carolina b

Saved Data Analyses

Tip

Projects Not Added

Contracts To Analyze Projects To Analyze

SC-2008-001 Clemson Bypass
SC-2008-004 _]
SC-2008-005
SC-2008-006 [<Remove |
Select an tem Options
Select Analysis Type
P-401 ~

Characteristics Not Added Characteristics Te Analyze

Select Clutput Type

Asphalt Content

_} Alrvoids
2 [tems to include
PryL Format, PF Format
D kot Round Do Mot Round
Do ot include Information O

Save Analysis

Type the name of the Analysis to

|C\emson Bypass - Desc Stat

[ Cancel ] L Submit ]

Any saved analysis will be displayed in the drop down menu that appears
by right-clicking on the Analysis icon that is at the top of each PWLPay
screen (see Figure 6.48). The user can then select the analysis that he or she
wishes to run. If Clemson Bypass - Desc Stat is selected in Figure 6.48, the
user is taken directly to the completed analysis screen shown in Figure 6.49.

Clemsaon Bypass - Mormality
Clemsaon Bypass - Pay Factors
Clemson Bypass - Run Charts

Welcome to PWL Pay
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& PWL Pay

File  Tools

I
" Federal Higl %
e T ; e S % . @ Administiation
State / Agency: South Carclina Please select a test category Total Statistics for characteristic: Asphalt Content

s B P Mean |57M25 Skewnese 07195
ore: b0 e STa g0t Std.Dev. ‘n 19435 Kurtosis ‘—1 23421
ian the 5 level of signifieance.
Summary Stafistics ‘Dela\\ed Statistics | Correlation Matrix|
Asphalt Content ‘ AlrVoids | WhAs ‘ Density |
Data Analysis
ContiactNa | Project Mame ¢ Number | Lat No. | Samplesize |LotMean | LotStdev. | FiojectMean | Projeot Stdev. | ContractM
SC-2008001  Clemson Bypass / District- 30 L001 4 58 0.14071 570125 019435 570125
L-002 4 56025 014033
L-003 3 5.76667 0.22679
L-004 5 5.662 0.24833

Figure 6.49 = ' —

Saved analyses can also be accessed from the Saved Data Analysis drop
down menu in the Analysis window (see Figure 6.50).

& PWL Pay
File

‘F.éder i (o}
f‘ )

Y
@ Administiation

Select a State [ Agency

Saved Data Analyses

Tip

Contracts Mot Added Contracts To Analyze Clemson Bypass - Norr Projects To Analyze
(GA-2008-001 | Clemson Bypass - Pay
_} Clemson Bypass - Run (g
Select an ltem Optians
Select Analysis Type
Characteristios Mot Added Characteristios To Analyze Select Cutput Type
Gt

ltems to include

Pl Format: FF Format
Do Mot Round Do Mot Round
Do nat include Infarmation Onl characteistics in s rport

by are some characteristies not isted?

Figure 6.50 -

Clicking on Tip shown in Figure 6.50 displays the window shown in Figure

E] 6.51. A saved analysis is opened by selecting it from the drop down menu
and clicking on Go.
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Saved Analysis Tip

.
\l) Selecting a saved analysis from the drop down list will Fill in the Farms below,

Figure 6.51

Deletinga A saved analysis can be deleting by clicking on Delete Selected Saved
Saved Analysis  Analysis as shown in Figure 6.50.

PWLPay User’s Manual 6-32



Chapter 7 Random Sampling

7 Random Sampling

Background

In most cases locations for samples obtained for testing are selected in some
random manner. This has traditionally been done by using a table of random
numbers. However, since effective computer algorithms are available for
developing lists of random numbers, random sampling locations can easily
and quickly be obtained from the computer. The PWLPay Random Sampling
window allows the user to generate random samples based on location,
guantity, or time.

The Random Sampling Window

The Random Sampling window allows the user to establish random

locations, quantities, or times for obtaining samples. Clicking on the Random
Sampling icon on any screen opens the Random Sampling window shown in
Figure 7.1. Identifiers, including State / Agency, Contract Number, Project
Name, ltem Number, and, optionally, Characteristic, are selected from
dropdown menus on the left side of the window.

B pWL Pay
Fle Tacks Navigale

Reports Administration

s SopPiojst  Anchss  Fandom Samplng Navi

Please select a State / Agency Interval Type

South Caroling v

Please select a Contract Number

@ By Quartity ) By Time [(hours: minutes]

SC-2008-001 4 Item units D Beghn tme ]
Please select a Project Name Item quantity l:l End time, :l

Clemson Bypass v

Project Number ihhzmm)

District-3-005-1

By Roadway Station
Please select an Item Nunbet O %

P-401 v Units
Inelude Characteristic
Plesse select a Characterisic B siten || Lane Posilen
Asphalt Content v
Endngsain| | Messazd Fom
Output Optiors Left Edge
Sample interval
Output to screen FRight Edge
] Output ta file Total width l:| Center Line.

Figure 7.1

Identifying the Sample  When the state or agency has been selected from the Please select a State /
Agency: dropdown menu, the Please select a Contract Number: menu is
populated with all contract numbers that have previously been assigned to the
state or agency selected. An example of this is shown in Figure 7.2a.
Similarly, once the contract number is selected, the Please select a Project
Name dropdown menu is populated with all projects associated with that
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Figure 7.2

Figure 7.3

Output Options

Figure 7.4

Interval Type

By Quantity

Random Sampling

contract number. The Project Number is automatically displayed for the
project name that was selected. An example of this is shown in Figure 7.2b.
The Please select an ltem Number dropdown menu is populated with all
items that are associated with the selected project (see Figure 7.2c).

Flezse select a Project Name

Clemson Bypass w

Praject Number
District-3-005-1

Please select a Contract Number
SC-2008-001

Please select a Project Name
Clemson Bypass “

Clemson Bypass k
Clemson Bypass Phase || P-401 v

Froiect Humber _

District-3-005-1 (C)
Based on the chosen item number, the user also has the option of selecting a
specific characteristic from the Please select a Characteristic dropdown
menu. If the Include Characteristic box is not checked, the screen appears as
shown in Figure 7.3a. If the Include Characteristic box is checked, the user
must select a characteristic from the Please select a Characteristic dropdown
menu and the screen appears as shown in Figure 7.3b.

Please select an ltem Number

(a) SC:2DDS—DDE (b)

Plezse select an ltem Mumber Please select an ltem Number

P-401 v F-401 v

[] Include Characteristic Include Characteristic

Please select a Characteristic

Asphalt Content ~

Air Vioids
Asphatt Content R
4 Density

(a) (b) M

As shown in Figures 7.4a and 7.4b, the user can choose to have the random
numbers Output to screen, Output to file, or to both. If Output to file is
selected, the user can then select whether or not to have the file open in Excel
upon completion of the random number calculations.

Output Options

Output to screen

[] Output to file

Output Options

Dutput to screen

Output to file

Show file after calculations are

complete.

(a) (b)

The Interval Type section of the Random Sampling window allows the user
to select the sampling format as well as the sampling interval. As shown in
Figure 7.5, random samples can be selected By Quantity, By Time
(hours:minutes), or By Roadway Station.

If By Quantity is selected as the Interval Type, the user must enter the ltem
units, ltem quantity, and Sample interval. For the example shown in Figure
7.6, the units for sampling are tons, the quantity to be sampled is 2500 tons,
and one sample is to be randomly obtained from each 500-ton increment.
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Figure 7.5

Figure 7.6

Once the unit, quantity, and interval values have been entered, the user
selects the Execute button to obtain the random sampling locations shown in
the screen output in Figure 7.7. If the user had also selected the option to

|rterval Type

@

(3 By Quartity

tomrie ||

Sample interval I:l

() By Roadway Station

Units

Beginning Station I:I
Ending Station I:l
Sample interval l:l

Total Width

By Quantity

ltem units  (tONS
Item quantity | 2500

Sample interval

() By Time [hours:mirwtes)

Begin time l:l
End time l:l

Sample interval l:l

(hhemm)

Lane Position l:l

Left Edas
Right Edge

Center Ling

Random Sampling

send the output to a file, then a CSV file also would have been created. The

CSV output file for the example in Figure 7.7 is shown in Figure 7.8.

Figure 7.7

Interval Type

Sample Number
485

Z 970
1060

3
4 1620
5 2170

Sarmple Guantity (tons)

Figure 7.8

PWLPay User’s Manual

W~ o (oW e

= e
M=o

A
State/Agency: South Carolina
Contract Number: SC-2008-001
Project Name: Clemson Bypass
Project Number: District-3-005-1

Sample Number

L R N R

B
Iltem Number: P-401
Item Units: tons
Item Quantity: 2500
Characteristic: Asphalt Content
Sample Interval: 500

Sample Quantity (tons)

970
1060
1620
2170
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By Time

Figure 7.9

Figure 7.10

Figure 7.11

By Roadway Station

Random Sampling

Once the random numbers have been output, the Execute button changes to
Start Over. Clicking on this button allows the user to start over with a new
set of options.

If By Time is selected as the Interval Type, the user must enter the Begin
Time, End Time, and Sample interval (hh:mm). For the example shown in
Figure 7.9, the beginning time is 7:00 AM, the ending time is 5:00 PM, and
one sample is to be randomly obtained from each 2-hour time interval.

(@ By Time (hours:minutes)
Begin time 700AM 2

Endtime DO0PM 2

Sample interval 200 3

(hhemm}

Once the beginning time, the end time, and sample interval values have been
entered, the user selects the Execute button to obtain the random sampling
times shown in the screen output in Figure 7.10. If the user had also selected
the option to send the output to a file, then a CSV file also would have been
created. The CSV output file for the example in Figure 7.10 is shown in
Figure 7.11.

Interval Type

Sample Mumber Sample Time
v 837 AM
2 10:39 A
1114 AM

3
4 2:08 P
5 4:28 PM

A B
State/Agency: South Carolina Item Number: P-401
Contract Mumber: SC-2008-001  Begin Time: 7:00 AM
Project Name: Clemson Bypass  End Time: 5:00 PM
Project Mumber: District-3-005-1 Characteristic: Asphalt Content
Sample Interval: 2:00 (hh:mm)

Sample Number Sample Time
8:37 AM
10:39 AM
11:14 AM
2:08 PM
4:28 PM

Wit |~ || b w k=

==
Ll =]
[CRF SRR

=
ra

If By Roadway Station is selected as the Interval Type, the user must first
select whether the Units are in hundred feet + feet or kilometers + meters.
Next, the Beginning Station, Ending Station, Sample interval, and pavement
Width are entered. The user also has the option to make an entry for Lane
Position. This could be used to enter information such as the lift, e.g., surface
course, or some descriptor such as Westbound Lane. Finally, the user must
indicate the reference for the transverse distance for locating the sample.
That is, the user indicates whether the distance is measured from the Left
Edge, the Right Edge, or the Center Line of the pavement.
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Figure 7.12

Figure 7.13

Figure 7.14

Partial Intervals

Random Sampling

For the example shown in Figure 7.12, the beginning station is 100+00, the
ending station is 150+00, and one sample is to be randomly obtained from
each 500-foot increment. The transverse distance is measured from the Right
Edge of the 24 foot pavement, and for a Surface course.

(%) By Roadway Station

Units

hundred feet + feet  w

Bedirning Station | 100+00 Lahe Pasition |Surface
Ending Station | 150+00 Measured From
O Left Edge
Sample interval | 500
(® Right Edge
Total Width |24 O Center Line

Once all of the information has been entered, the user selects the Execute
button to obtain the random sampling locations shown in the screen output in
Figure 7.13. If the user had also selected the option to send the output to a
file, then a CSV file also would have been created. The CSV output file for
the example in Figure 7.13 is shown in Figure 7.14.

Interval Type
Sample Number Roadway Station From Right Edge

’ 101 + 86 1s

Z 107 +13 9.1

3 110 +86 8.0

4 119 +02 15

5 121 +40 28

B 127 +18 108

7 134+493 5.0

g 136+ 16 6.6

4 141 +35 9.1

10 145 + 36 6.7
*

A B €

1 |State/Agency: South Caralina Item Units: hundred feet + feet
2 | Contact Number: SC-2008-001 From Right EdgeProject Name: Clemson Bypass  Width: 24
3 | Project Number: District-3-005-1 Lane Position: Surface
4 |Item Number: P-401 Sample Interval: 500
5 |Characteristic: Asphalt Content  Beginning Station: 100+00
6 Ending Station: 150+00
7
8 Sample Number Roadwy Station From Right Edge
9 1101+86 0.8
10 2107+13 9.1
11 3 110+ 86 8
12 4 119+02 11.5
13 5121+40 2.8
14 6127+15 10.9
15 7 134+93 3
16 8 136+16 6.8
17 9 141+35 9.1
18 10 145+ 36 6.7

For some materials the sample intervals may not divide evenly into the total
material quantity or time to be sampled. For example, if the sample interval
is 500 units and the total quantity to be sampled is 2,400 units, then there will
be 4 full sample intervals of 500 units, with an additional 400 units
remaining for the last sample interval.
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There are a number of different ways that might be used by different owners
to handle the situation of uneven sample intervals. Sample intervals are often
referred to as sublots. Some possibilities for handling unequal sublots
include:

e treating the partial sublot as its own sample interval.

e combining the partial sublot with the last complete sublot to make a
larger final sublot.

o dividing the total quantity to be sampled into a desired number of
complete sample intervals. For example, if the owner wanted a
sample size of 4, then the 2,400 units could be divided into four 600-
unit sublots.

There are additional provisions that could be incorporated into the three
options above. For example, the owner might have a policy to treat the partial
sublot as a full sublot if it is over some threshold quantity, but to combine it
with the last complete sublot if the partial sublot is below the threshold
quantity.

PWLPay does not attempt to account for all of the possible combinations of
ways to deal with partial sublots. PWLPay treats any partial sublot as a
complete sublot when it generates random sampling locations. Therefore, in
the above example, PWLPay would provide 5 random sampling locations—
one within each of the four 500-unit sublots, and one within the last 400-unit
sublot. Examples of the input and output for this example case are shown in
Figures 7.15a and 7.15b, respectively.

() By Quantity Sample Number Sample Quantity (units)

i units > A -0

835

1155
1740
2100

ltem quantity | 2400

Sample interval 500

Figure7.15  (a) (b) *

As shown in Figure 7.15b, PWLPay has developed 5 sample quantities. The
first 4 are each within one of four complete sample intervals or sublots. That
is, 460 is between 0 and 500, 835 is between 500 and 1,000, 1155 is between
1,000 and 1,500, and 1740 is between 1,500 and 2,000. The final sample
quantity, 2100, is within the last partial interval from 2,000-2,400.

If necessary, the user can choose to make adjustments in the random sample
guantities, times, or locations. For instance, if the user desired exactly four
tests in the previous example, then the sample interval could have been
entered as 600 (i.e., 2400/4), rather than 500. Or, if the user wished to
combine the partial sublot with the last full sublot, then the sample could be
taken at either 1740 or 2100 units. This approach would more likely be
chosen when the partial sublot was a relatively small quantity in comparison
to the full sublots. In the above example, it is more likely that the last 400-
unit sublot would be treated as a separate sublot as shown in Figure 7.15b.
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8 Navigating PWLPay

Navigation Options

There are two different methods by which the user can navigate quickly to
the desired location within PWLPay. These are the Navigation Tree and the
Navigation pane. The Navigation Tree icon appears at the top of any screen,
as shown in Figure 8.1. The Navigation pane appears on the right hand edge
of any screen, and is the shaded region on the right side of Figure 8.1.

B pWL Pay

Fle Taok Navigslz Help

o

e

' Fec?erul
Reports @ Administrati

(7] %

s SetupPiojst  Ansbsis  Flandom Samplin

Welcome to PWL Pay

Recent Projects Project# Date Madified Date Creatsd
Clemson Bypass District-3-005-1 Ssturday, March 21, 2009 Tuesday, Fabruary 27, 2007
Highway 83 Dishict-3-0110 Sunday. Ootaber 26, 2008 Tuesday. February 27, 2007 B Test Resul
Clemson Bypass Phas  District-3-005-2 Faturday, Detober 25, 2008 Thursday, Hovember 29, 2007
|26 Dist-1-M0 ‘Wednesday, October 22, 2008 Thursday, October 04, 2007
Us-123 Dist-7-011 “Wednesday, October 22, 200% *Wednesday, October 03, 2007
SR-28 Dist7-010 “Wadnesday, Octaber 22, 2008 Monday, July 02, 2007
Route 76 Distict-1-005 Weshasday. Ootaber 22, 2008 Wednesday. June 13, 2007 TR
Athens Frasway Athens-001 Tuesday. July 15, 2005 Thursday. Dotober 04, 2007 dd Test Resul

Create New / Edit Project

Database Location: &iFregram FilteslFHWAIPWE PaiDatabase FeslPWE-Fay-Sampla-Database mdb

Figure 8.1

The Navigation Tree

The Navigation Tree window allows the user direct access to most locations
within PWLPay. Clicking on this icon opens the Navigation Tree window
shown in Figure 8.2a.

The Display Format  The first level shows all states and/or agencies that have been entered.
Clicking on = opens the next level, showing all contract numbers assigned to
the selected state or agency. The user can continue expanding the tree until
all item numbers have been displayed. For example, the following selections
have been made to arrive at the screen shown in Figure 8.2b:

State:  South Carolina
Contract Number:  SC-2008-001
Project Name - Number:  Clemson Bypass - Distrtict-3-005-1
Item Number:  P-401
Characteristic.: =~ Asphalt Content.
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Figure 8.2

Figure 8.3

Navigating

Navigating PWLPay

® ficorgia & Gieorgia
2 South Carclina = Seuth Carolina
Westem Federal Lands = 5C-2008-00
3 Clemson Bypass - Distict3-005-1
= P01
(Asphalt Content
AirVaids
VM
Diensity
#- Clemson Bypass Phass Il - District-3-005-2
- SC-2008-002
#- SC2008003
- SC-2008-004
- SC2008005
#- SC2008008
Western Federal Lands
(a) Expand Al Close (b) Expand Al Close

The user can quickly show all of the navigation tree by selecting Expand All
shown at the bottom of the windows in Figure 8.2. This results in the window
shown in Figure 8.3. Note that Expand All has been replaced by Collapse All
as an option at the bottom of the window. Selecting Collapse All would
collapse the tree to the one shown in Figure 8.2a. The user can also collapse
any individual tree level by clicking on the corresponding = box.

= Georgia A
= GA-2008-001
=1 Athens Freeway - Athens-001
= P-G55
Dengity
Thickness
Bulldog Index
= South Caroling
= SC-2008-001
=) Clemson Bupass - District-3-005-1
= P-401
Asphalt Cantent
AirVoids
WA
Diensity
=) Clemson Bypass Phase Il - District-3-005-2
= P-401
Azphalt Content
Air Voids
WA
Density
= SC-2002-002
= Highweay 93 - District-3-010
= P-a01
Azphalt Content ¥
Collapse Al Close:

The user can double click on any level of the navigation tree to go directly to
a specified location. If the user clicks on either the state/agency level or the
contract number level, he or she is taken to the Setup Project screen. If the
user clicks on any level below the contract number, he or she is taken to the
Add Samples window for the selected project.

For example, for the tree shown in Figure 8.3, double clicking on a
state/agency, such as South Carolina, or on a contract number, such as SC-
2008-001, takes the user to the Setup Project screen shown in Figure 8.4.
Double clicking at the project level, such as Clemson Bypass - District-3-005-
1, or below, takes the user to the Add Samples window shown in Figure 8.5.
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& PWL Pay

File
5

" Federal Higl

¥
@ Administration

Home

Selectthe contract number !

Add New Contract Mumber

Selecta Project Name / Project Number and click the Continue buttan

Add Mew Project

Figure 8.4 ] |

& PWL Pay
Fie T
T il o
" Federal Highway
v = @ Administiafion
Itern Number: Spec Type: HE

Project Name:  Clemson Bypass
target value * tolerance
Project Number:  District-3-005-1 Target
Characteristic 57
MHOTE: Click the 4 1o 3dd new items to 3 drep dovin box o
Lot Number | SampleNo. | Date | TestResut | Conti/Owner | Lab Name | Tester D | Split Sample No. | Split Test Result | SpltLab Name

» L0t S01C 10/4/2007 586 Cantractar 1-Contractor 56 sms 56 1-District
Lom S-02 10/4/2007 561 Cantractar 1-Contractor 456

Lom 503 10/4/2007 5. Cantractar 1-Contractor 456

Lo S04 1o/4/2007 579 Cantractar 1-Contracter 456

Lom2 50 10/9/2007 578 Contiactor  1-Contiacter M55

Lom2 5020 10/3/2007 565 Contractor  1-Conlractar 56 5025 565 1Distrct
Loz 50 10/3/2007  5.49 Contractor ~ 1-Contiactor 3456

Loz S04 10/3/2007 549 Contractor  1-Contractor 3456

Lom s0c 10/22/2007 6.9 Contractor  1-Conbactor 3456 5015 564 1 District
Lom s02 10/22/2007 551 Contractor  1-Conbactor 3456

- Lom 503 10/22/2007 585 Contractor  1-Conbactor 3458

Lo sm 11/13/2007 535 Contractor  1-Conbactor 3458

Lo s 11M13/2007 57 Contractor  1-Conbactor 3458

Lo s03C 11132007 .47 Contractor  1-Conbactar 3458 5025 569 1 District
Lo S04 11M13/2007 585 Contractor ~ 1-Contiactar 56

Lo 505 111132007 593 Contractor ~ 1-Conbiactar 56

Figure 8.5

The Navigation Pane

The Navigation pane allows the user direct return access to screens that he or
she has previously visited in PWLPay. All of the visited screens appear as a
list in chronological order, from top to bottom, on the shaded right edge of
any PWLPay screen. An example is shown in Figrue 8.6, although, since it
appears on every screen, the Navigation pane is visible in many of the figures
in this manual.
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Figure 8.6

Navigating

Close

Figure 8.7
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& PWL Pay
File  Tools

avigate  Help

1 By 7

Setup Praect

7S P redcral Highuay

@ Administiation

Analysis Random Sampling __ Mavige

Welcome to PWL Pay

Recent Projects Project# Date Modified Date Created
Clemson Bypass District-3-0051 Saturday, March 21,2009 Tuesday, February 27, 2007
Highway 93 Distich- 3010 Sunday, October 26, 2008 T 7, 2007
Clemson Bypass Phas  Distict 30052 Satunday, October 25, 2008 s, Hovember 26, 2007
26 Dist1-010 ‘Wednesday. October 22, 2008 Thursday. October 04, 2007
uUs-123 Dist-7-011 ‘ednesday, October 22, 200% “ednesday, October 03, 2007
SR-28 Dist-7-010 ‘ednesday, October 22, 2008 Monday, July 02, 2007
Floute 76 Distich-1-005 Wedhasday, Dctober 22, 2008 Wednesday, June 13, 2007

Athens-001

Athens Freeway Tuesday, July 15, 2008 Thursday, Octaber 04, 2007

Create New / Edit Project

DatabaseLocation: CiFragram FileslFHWAIPWL PaiDatsbase FilteslPWi-PaSample-Datebase mdb

As can be seen in the list (above the arrow cursor) in the Navigation pane in
Figure 8.6, the user has visited six different locations in addition to the Home
screen that automatically appears when PWLPay is opened. These include the
Setup Specs, New Project / Edit Mode, Add Samples (twice), Data Analysis,
and Random Sampling. The two Add Samples locations could have been for
different projects or items, or could have been the same screen twice.

If the user wishes, locations can be removed from the Navigation pane by
right clicking the mouse on the location and then selecting Close in the
window that pops up. This process is shown in Figure 8.7a. If desired, the
user can open the Navigation Tree from the Navigation pane by clicking
anywhere in the title region at the top of the Navigation pane. As shown in
Figure 8.7b, this opens a window that allows the user to select to go to the
Home page or to Open Navigation Tree.

Home: Home

Setup Specs. Open Mavigation Tree Home R
Mew Project / Edit Mode Setup Specs
Add Samples New Project / Edit Mode
Data Analysis Add Samples
Add Samples, Data Analysis
Random Sar Add Samples
(a) (b) Random Sampling

Clicking on a location in the Navigation pane returns the user to the selected
screen as it appeared when the user left that screen. That is, any selections
that had been made or data that had been entered will be on the screen when
it is re-visited. For example, Figure 8.8 shows what the screen might look
like if Data Analysis is selected from the Navigation pane in Figure 8.6.
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Figure 8.8

| Begin Analysis >> |

Figure 8.9

Navigating PWLPay

& PWL Pay
le  Tools N

e

Hepots @ Administration

Select a State [ Agency

South Carolina by

Contracts Mot Added

Saved Data Analyses

o
Clemson Bypass - De ¥ @ Delet Salected Savad Snslysis

Projects Not Added

01 Clemson Bypass Fi

Contracts To Analyze

Projects To Analyze

SC-2008-003
SC-2008-004
SC-2008-005
SC-2008-006

Select an ltem Optians
Select Analysis Type
P-401 ~ SE

Characteristics Mot Added

Descriptive Statistics b

Characteristics To Analyze Select Output Type

[tems to include

Pyl Format, PF Format

Do kot Round Do Mot Round

Do ot include Information Dl o

Save this Analysis

< in this 1epoit

Figure 8.8 shows that a Descriptive Statistics analysis was either set up or
performed on item P-401 for the Clemson Bypass project on contract SC-
2008-001 in South Carolina when the user was on this screen. The user can
now select a different analysis procedure or modify any of the other
selections before again selecting Begin Analysis.

Similarly, Figure 8.9 shows what the screen might look like if Random
Sampling is selected from the Navigation pane in Figure 8.6.

B pWL Pay
Fle  Took Mavigate H

-

Reports '.-r Administration

s SopPiojst  Ansbss  Fan

Please select a State / Agency Interval Type

<

South Caroling

Please select a Contract Number
SC-2008-001

I

Please select a Project Name:

I

Clemson Bypass

Praject Number
District-3005-1

Please select an ltem Number
P-401

I

Include Characteristic

Please select a Characteristic

I

Asphalt Content

Output Options:
Qutput to screen
[[] Output to file

@ By Quartity

ltemunits [1oNs
Itern quantity | 2500

) By Roadway Station

Units.

Total Width

©) By Time (howrs:minutes)

P ]
gowme [ 7]

ihhzmm)

Measured From
Left Edge
Fiight Edge

Center Line
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Creating a Report

Figure 9.1

Figure 9.2

Reports

9 Reports

Saving Reports

As seen in Chapter 6, an analysis can be saved so that it can be run with just
one click of the mouse. This is an important and time saving capability since
some analyses may be run repeatedly throughout the course of a project. The
Reports icon extends this one-click capability to multiple analyses.

Before a report can be created the user must have saved at least one analysis
as explained in Chapter 6. The Reports window can be reached by clicking
on the Reports icon at the top of any screen and selecting New Report from
the drop down menu as shown in Figure 9.1.

&5 PWL Pay

File  Tools Mavigate Help

!EE‘ ,\/v = @k

Setup Project Analysis Fandom 5 ampling REV ree Mew Report

The Reports window is shown in Figure 9.2. Any previously saved reports
will appear in the Saved Reports drop down menu. In Figure 9.2 this
window has defaulted to ..Add New Report, signifying that no reports have
previously been saved. The user can create a new report by entering a Report
Name: and using the Add >> or Select All >> button to move saved analyses
from the Analyses Not Added window to the Analyses Included in Report
window.

Reportbame |

Analyses Mot Added Analyses Included in Report

Y
Clemson Bypass - Pay Factor
Clemson Bypass - Run Charts

Add Saved Analyses
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Figure 9.3

Figure 9.4

Reports

Figure 9.3 shows a report named Clemson Bypass that is ready to be saved
by clicking on Save.

& pWL Pay

Fle Tooks Navigate Help

e PN Fecioral Highway

Reports ‘@ Administration

Ll i

ces _ Selup Froject

Analysis

Analyses Mot Added

Clemson Bypass - Pay Factor
Clemson Bypass - Run Charts

£idd Saved Analyses

The user selects Save to save the report under the name appearing in the
Report Name: box. Saved reports can be accessed directly from the Reports
icon, as shown in Figure 9.4.

88
ol

Home iF etup Project R andom Sampling

Selecting a report in the drop down menu shown in Figure 9.4 causes all of
the analyses assigned to the report to be executed and to appear in the
Navigation pane for easy access. For example, if Clemson Bypass is selected
in Figure 9.4, the four analyses assigned to it in Figure 9.3 will be completed
and the screen shown in Figure 9.5 will be displayed.

The four analyses assigned to the Clemson Bypass report (see Figure 9.3)
have been conducted and they now appear in the Navigation pane. The last
analysis in the list, Process Control, is active on the screen shown in Figure
9.5. The user can click on any of the analyses in the Navigation pane to
switch to the selected completed analysis screen.
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& PWL Pay

' Federo le] y
@ Administration

Please select a Project Name:

State / Agency: South Carolina Flease select a test category. Project Numher:

lerm Mumber: P-401 ‘AHCnmramanests V| |C\emsﬂn Bypass v‘ Bl BEE

Asphalt Content | Air Woids ‘ Wi | Density ‘

Spec Type: Target value + Tolerance

Run Chart

Run Chart for: Asphalt Content

/\~\ /\/\ //
\—/\/\/

e
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&07 Sy Sy R, S0, &Q? Sgp" %0, &07 Sgy Rgy %o, Ry &03 &Oq S5

o,
~

@
=)
!

Asphalt Content

Lot Murnber - Sample Nurmber

Figure 9.5

Deleting a Saved Report

A saved report can be deleted by clicking on Delete this saved report as
shown in Figure 9.3.
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10 Working with Charts

Printing, Saving, and Copying Charts

As seen in previous chapters, there are many charts (plots) that can be
displayed in PWLPay. Nearly all of these charts can be printed, saved, or
modified by clicking the right mouse button while the cursor is over any area
of the plot. When this is done, the menu shown in Figure 10.1 pops up.

Multiple Graph B

Pay Factor vs. PWL

110 Equation Mame: AASHTO

1S
90 +

80 +
70 1

= % Print Cﬁart .
E B0 = Print Setup
i J B
ERIE Save to File 4
(i L Copy to Clipboard
40 = Shaw Data
i Properties
30 - ?
20
10 4
0 T T T T T T T T T T T T T T T T T T T 1
0 10 20 30 40 50 G0 70 a0 a0 100
Percent Within Limits
Right click on graph
fefior= oplighs TIP: hkdowee the mouse auver the graph to see data points

Figure 10.1

Printing a Chart  In the popup menu shown in Figure 10.1, clicking Print Setup or Print Chart
opens the Print menu for the default printer associated with the computer on
which PWLPay is currently running.

Saving a Chart  In the popup menu shown in Figure 10.1, clicking Save to File opens the
submenu shown in Figure 10.2. Save Chart to File allows the user to save the
chart as a picture in an EMF, BMP, GIF, JPG or PNG format. Save Data to
File allows the user to save the chart data in a CSV file format.

Print Chart
Print Setup

m Save Chart to File
Copy to Clipboal » Save Data to File
Show Data

Figure 10.2 Properties
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Copying a Chart

Figure 10.3

Viewing Chart Data

Figure 10.4

Working with Charts

In the popup menu shown in Figure 10.1, clicking Copy to Clipboard opens
the submenu shown in Figure 10.3, and allows the user to copy the chart to
the clipboard as a picture in one of the file formats shown. The chart can then
be pasted from the clipboard into another program.

Print Chart
Print Setup

Save to File 4

Shaow Data k Copy as EMF

Properties Copy as EXIF
Copy as GIF
Copy as Icon
Copy as JPEG
Copy as PNG
Copy as Tiff
Copy as WMF

In the popup menu shown in Figure 10.1, clicking Show Data opens the
Graph Data window shown in Figure 10.4. This window allows the user to
see the values of the data points that are plotted in the chart.

Data Points from Graph

55
5b.5
56
56.5
57
57.5
58
58.5
59
59.5
60

(=]

TR

< >

Right click data for options

Modifying Chart Properties

In the popup menu shown in Figure 10.1, clicking Properties allows the user
to change the properties of the chart with respect to colors, scales, titles, etc.
Selecting Properties opens the Chart Properties window shown in Figure
10.5.

The charting module in PWLPay was licensed from ComponentOne (hence
the €O in the lower left corner of the Chart Properties window) and
provides powerful charting capabilities. Most of these capabilities are not
needed for PWLPay, but they are still available from the Chart Properties
window.
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Figure 10.5

Chart Type

Chart Properties

PWLPay User’s Manual

Working with Charts

Chart Properties El
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L ﬂ Brea
T T T g K. | =1 chart, linez, symbolz
aican Wt L —
€O ox J (Cconeel ]

Gallery is highlighted in the upper left corner of the Chart Properties window
shown in Figure 10.5. From Gallery the user can select from several simple
and complex types of charts (e.g., Scatter, Step, Column, Bar, Area, etc. in
Figure 10.5). The Line chart type is the one of most interest to the user since
this chart is used nearly exclusively in PWLPay. The user might switch to a
Scatter plot, for example, if they did not want lines connecting the points on
a control chart. However, this manual limits its discussion to the properties of
Line charts since they predominate in PWLPay.

Note in Figure 10.5 that a small preview of the chart is always available in
the lower left corner of the Chart Properties window. Clicking the Preview
tab displays a larger preview of the chart (see Figure 10.6).

Selecting Data in the upper left window (see Figure 10.5) allows the user to

change the line style, thickness, and color of the lines and/or symbols in the
plot. These options are shown in Figure 10.7.
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=
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Figure 10.6

Chart Properties rgl
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@l Data [[] &tacked
:J_i| Binding Data Series: Label:
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10 sy v
4 | >
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=
e | |

co [ K ] ’ Cancel ] ’ Apply ]

Figure 10.7

Similarly, selecting AxisX or AxisY in the upper left window allows the user

to change the axis title, font style, font size, color, and location. The user can
select Gridlines to add them to or remove them from either axis. The scale of
either axis can be changed by selecting the Scale tab. Some of these options

are shown in Figure 10.8.

Chart Appearance  Selecting Appearance in the upper left window (see Figure 10.9) allows the

user to add or to modify the appearance of a Header, Footer, or Legend, or to
modify the appearance of the ChartArea or PlotArea.
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Figure 10.9
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Figure 11.1

Figure 11.2

Computational Methods

11 Computational
Methods

Overview

PWLPay obviously incorporates a number of computational methods in its
various analysis modules. Some of these are obvious, while others may not
be as obvious to the user of the program. This chapter is not intended to
explain in detail the theory that underlies these methods. It does, however,
expand on some computational methods that may not be familiar to the
typical PWLPay user.

Tools is one of the options that appear at the top of every PWLPay screen.
The drop down menu under Tools has Computational Routines as one of its
options (see Figure 11.1). This chapter explains the various options that are
available under Computational Routines. The chapter also includes a
discussion of the various normality testing methods used by PWLPay.

ol Mavigate  Help

Database Options

*
Mormality Chedk bk

Distribution Calculakor
Correlation

Distribution Calculator

PWLPay uses several probability distributions while performing the various
analyses of which it is capable. Selecting Tools » Computational Routines »
Distribution Calculator opens the Distribution Calculator window shown in
Figure 11.2. This window allows the user to calculate areas under the ¢-, F-,
and Beta distributions. The critical values corresponding to any selected level
of significance can also be calculated for each of these distributions.

Distribution Calculator &3]

Use this tool to check the validity of the statistical routines built
into this software

X Degrees of Freedom Tails
& TDIST O FDIST ) Beta []inverse

Result: 0
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There is no need to use these calculations when using PWLPay pay. The
appropriate calculations are automatically performed by the program. It is
included only to allow the user to verify the PWLPay calculations if desired.
The values calculated using the Distribution Calculator can be checked
against those calculated by other programs such as Excel.

If desired, the user could use this window as a separate calculation tool when
working with these distributions in settings other than using PWLPay.

TDIST  Selecting the T DIST button in Figure 11.2 allows the user to calculate the
t-distribution and its inverse. PWLPay uses these calculations when
performing z-tests as part of the verification analysis option. The -
distribution and -tests are explained in detail in numerous statistical tests,
and are covered in this manual only for illustrative purposes.

The z-distribution and the values calculated with T DIST are illustrated in

Figure 11.3.
%7/\ ® TDIST [“1linverse
Result
/\&
Figure 11.3 (a) X (b) Result

Example 1. Suppose that the z-statistic from a one-tailed ¢-test is determined
to be 1.42 and there are 10 degrees of freedom. The Result: in Figure 11.4
shows that the probability of receiving a #-statistic greater than or equal to
1.42 (i.e., the non-shaded area in Figure 11.3a) is 0.093.

Use this tool to check the validity of the statistical routines built
into this software.
X Degrees of Freedom Tails
142 10 1
® TDIST O FDIST ) Beta [ inverse
ECaiculalel
. Result: 0.0930120191399093
Figure 11.4

Example 2. Suppose that in the previous example the user wishes to know
the critical z-value that corresponds to a level of significance, = 0.05. In

this case the user checks the inverse box and enters 0.05 in the X box. The
Result: in Figure 11.5 shows that the critical value is 2.228.

Use this tool to check the validity of the statistical routines built
into this software.

X Degrees of Freedom

0.05 10
@® TDIST QO FDIST O Beta inverse
ECaiculate]
. Result: 2.22813885198627
Figure 11.5
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F DIST

Figure 11.6

Figure 11.7

Figure 11.8
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Selecting the F DIST button in Figure 11.2 allows the user to calculate the
F-distribution and its inverse. PWLPay uses these calculations when
performing F-tests as part of the verification analysis option. The F-
distribution is based on the ratio of variances, and is characterized by the
degrees of freedom in the numerator and degrees of freedom in the
denominator of this ratio.

In Figure 11.6, Degrees of Freedom 1 is for the numerator, while Degrees of
Freedom 2 is for the denominator. It is important to have these values correct
since the degrees of freedom are not interchangeable. That is, for example,
the F-distribution with 10 degrees of freedom in the numerator and 12 in the
denominator is NOT the same as one with 12 degrees of freedom in the
numerator and 10 in the denominator.

Distribution Calculator 3]
Use this tool to check the validity of the statistical routines built
into this software.
X Degrees of Freedom 1 Degrees of Freedom 2

QToIsT @FDET ) Beta

Calculate

[]inverse

Result: 0

The F-distribution and the values calculated with F DIST are illustrated in
Figure 11.7.

@ FDIST © FDIST

[]inverse |

Result X

(a) X (b) Result

Example 1. Suppose that the F-statistic from an F-test is determined to be
2.906, there are 20 degrees of freedom in the numerator, and 5 degrees of
freedom in the denominator. The Result: in Figure 11.8 shows that the
probability of receiving an F-statistic greater than or equal to 2.906 (i.e., the
non-shaded area in Figure 11.7a) is 0.120.

Use this tool to check the validity of the statistical routines built

into this software.

X Degrees of Freedom 1 Degrees of Freedom 2
2.906 20 5

QO TDIST (& FDIST () Beta []inverse

Result: 0.120051669565881

Example 2. Suppose that in the previous example the user wishes to know

the critical F-value that corresponds to a level of significance, = 0.05. In
this case the user checks the inverse box and enters 0.05 in the X box. The
Result: in Figure 11.9 shows that the critical value is 4.558.
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Figure 11.9

Beta

Figure 11.10

Figure 11.11

Figure 11.12

Distribution Calculator 3]

Use this tool to check the validity of the statistical routines built
into this software.

X Degrees of Fresdom 1 Degrees of Fresdom 2
0.05 20 5
QTDoIST @® FDIST O Beta inverse

| Caleulzte

Result 4.55813149739653

Computational Methods

Selecting the Beta button in Figure 11.2 allows the user to calculate the

Beta distribution and its inverse (see Figure 11.10). PWLPay uses these
calculations when determining PWL values in the payment factor and risk
analysis options. The Beta distribution is particularly useful when dealing
with percentages since it always ranges between 0 and 1, and because it can
take on a wide variety of shapes depending upon the value of its two
parameters, Alpha (o) and Beta (/). Figure 11.11 illustrates this versatility of

shapes.
DistributionCalculatr &
Use this tool to check the validity of the statistical routines built
into this software.
X Alpha Beta
O TDIST O FDIsT @Beta! [Jinverse
Result 0

A Beta distribution illustrating the values calculated with Beta is illustrated

in Figure 11.12.

Result
@® Beta

@® Beta [Alinverse |

(a) X

PWLPay User’s Manual

i (b)

Result 1
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Figure 11.13

Figure 11.14

Figure 11.15

Graphical
lllustration
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Computational Methods

Example 1. Suppose that we have a Beta distribution with = = 2. The
Result: in Figure 11.13 shows that the percentage of the distribution with
values less than or equal to 0.70 (i.e., the non-shaded area in Figure 11.12a)
is 0.784.

Distribution Calculator 3]
Use this tool to check the validity of the statistical routines built
into this software.
X Alpha Beta
QO TDIST O FDIST (&) Beta [ inverse
Result: 0.784

Example 2. Suppose that in the previous example the user wishes to know
the value for which 60 percent of the distribution is less than. In this case the
user checks the inverse box and enters 0.60 in the X box. The Result: in
Figure 11.14 shows that the value is 0.567.

Distribution Calculator 3]

Use this tool to check the validity of the statistical routines built

into this software.
X Alpha Beta
QO TDIST QO FDIST @ Beta imverse

T

Result: 0.567068922852268

Correlation

PWLPay can perform analyses for independent or correlated characteristics.
Selecting Tools » Computational Routines » Correlation » provides the user
with the two options shown in Figure 11.15. Each of these is discussed in a
separate section below.

&1 pWL Pay

File  Tools Mavigate Help

Database Optians =2
Mormality Check k

dom Sampling

Graphical Hustration
4 Correlated Random MNumbers

Graphical lllustration provides the user visual examples of various levels of
correlation between two variables. It also illustrates the effectiveness of the
random number generating routines used by PWLPay. Selecting Graphical

lllustration opens the Correlated lllustration window shown in Figure 11.16.
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Figure 11.16

Random Normal
Generator

Figure 11.17
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8 Correlated Illustration E@
Choose the number of characteristics for the example
Two Characteristics R
Three Characteristics
Four Characteristics
hode
@ Fiandom Nomal Gererator O Histogram (1,000 times) oo =
Iteratiors i X
Mean I
Std dev 1
»  Cancel =y

As shown in Figure 11.16, the Choose the number of characteristics for the
example drop down menu allows the user to select two, three, or four
characteristics for which random numbers will be generated. Also note that
in the Mode section the user can choose from Random Normal Generator or
Histogram (1,000 times). These are discussed in separate sections below.

Random Normal Generator results in the computer generation of up to four
random normal characteristics with a desired correlation structure that is
input by the user. The number of values generated for each characteristic is
that shown in the lterations box. The number of Iterations is theoretically
unlimited. However, for illustration purposes the default value of 10,000
should be quite sufficient in most cases.

Once the user selects the number of characteristics, a correlation matrix (see
Figure 11.17) is displayed and the user then enters the correlation
relationships between each pair of characteristics.

8 Correlated lllustration

Choose the number of characteristics far the example

Enter the comelation coefficients between sach pair of characteristics:

Characteristic Characteristic 2 Characteristic 3 Characteristic 4

Characteristic 1
Characteristic 2
Characteristic 3

Mode

(%) Random Mormal Generator ) Histogram (1,000 times)

lterations 10000 %

Mean 2

Std dev Ik

¥ Cancel =y
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Figure 11.18

Figure 11.19

Computational Methods

PWLPay automatically checks and issues a warning message in the event that
there are inconsistencies in the correlation coefficients entered. For example,
if Characteristic 1 is positively correlated with both Characteristic 2 and
Characteristic 3, then Characteristic 2 and Characteristic 3 could not be
negatively correlated. So, if the correlation coefficients shown in Figure
11.18 were entered, when Continue was selected, the warning message in

Figure 11.18 would be displayed.

Choose the number of characteristics for the exampls
Thiee Characteristics v
Enter the corelation coefficients between each pair of characteristics:
Characteristic Characteristic 2 Characteristic 3
Charasteristic 1 075 5 ‘
Characteristic 2 [078 ‘
Error in correlation coeffs
Mode 6 This cambination of corvelation cosffs is inconsistant
(®) Random MNormal Generator 1 =
S
Mean o ]
Std dev [ ]
b 4 Cancel
T
Gonerting i 0% [ 5o ]

The user can use the default values, mean = 0 and standard deviation =1, or

can enter a desired mean and stan

dard deviation. If a consistent correlation

matrix has been entered, selecting Continue begins the random number
generating process and then presents the results, including a plot of the

values generated.

Example. Suppose the user has entered the values shown in Figure 11.19.
Selecting Continue results in the screen shown in Figure 11.20.

8 Correlated Illustration

Choose the number of characteristics for the example

| Thiee Characteristics v

Enter the camrelation coefficients between each pair of characteristics:

Characteristic Characteristic 2

Characteristic 3

Characteristic 1 [o7s | |0.50

Characteristic 2 025

hode

(%) Random Nomal Generator ) Histogram (1,000 times)

Mean [o |

Std dev |1 |

Isrations 10000 %

X Concel

PWLPay User’s Manual
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Figure 11.20

Histogram
(1,000 times)

Computational Methods

¥ Correlated lllustration E@E}

Fiesults for 182 | Results for 1 &3] Resulbs for 283
Comparizon between 1 2
Group 1 Group 2 3:
Average 001448 00077
Stdl dev 0163124 100483 o

Skewness 005401 000464

Correlation  0.75114

Show data set 4

Print Graph

Change Numbers

Note from Figure 11.19 that for each characteristic the simulated mean was 0
and standard deviation was 1. Also, the correlation coefficient between
Characteristics 1 and 2 was 0.75. Figure 11.20 shows that the means for the
10,000 random numbers generated (i.e., 0.01448 and -0.00177) were close to
the population mean of 0, and that the standard deviations of the generated
numbers (i.e., 0.99124 and 1.00493) were close to the population value of 1.
Finally, the correlation coefficient for the generated numbers (i.e., 0.75114)
was close to the input value of 0.75.

The positive slope of the plot of the generated numbers shows that the two
characteristics are positively correlated. The amount of spread around the
line that fits the data is consistent with the correlation coefficient of 0.75.

The results in Figure 11.20 are for the correlation between Characteristics 1
and 2. This is shown by the Results for 1 & 2 tab that is highlighted at the top
left of the window. The user can select the other tabs to see the

Results for 1 & 3 or Results for 2 & 3.

Figure 11.21 shows the plots for the generation of two variables with various
correlation coefficients.

The output from Random Normal Generator (see, for example, Figure 11.20)
includes the mean, standard deviation, skewness coefficient, and correlation
coefficient for the generated values. Selecting Histogram (1,000 times)
causes the Random Normal Generator function to be repeated 1,000 times. It
then plots histograms of the 1,000 means, standard deviations, skewness
coefficients, and correlation coefficients. Note that when Histogram is
selected the analysis is always performed using only Characteristic 1 and
Characteristic 2, regardless of the number of characteristics showing in the
Choose the number of characteristics for the example window.

PWLPay User’s Manual 11-8
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(@)

Figure11.21 (c)

Since Histogram repeats the Random Normal Generator function 1,000
Important Note on times, the user should consider carefully the value selected in the Iterations

AR window. A large value for lterations can lead to a long wait when repeated
1,000 times. For this reason, the default value for Iterations is 10 when
Histogram is selected. However, the number of iterations can be set to
whatever value is desired.

lterations

The Histogram option allows the user another method to verify that
PWLPay’s random number generating routine is operating properly. This is
illustrated and discussed in the following examples.

Example 1. Suppose the user has entered the values shown in Figure 11.22.
The correlation coefficient has been entered as 0.0, which would be the case
if the two characteristics are independent of one another. The default Mean,
Std dev, and Iterations values have been used.

% Correlated Illustration Q@@
Choose the number of characteristics for the example
| Twio Characteristics . |
Enter the comelation coefficients between each pair of characteristics:
Characteristic Characteristic 2
Characteriztic 1 [oo
Iode
() Random Mormal Generator () Histogram [1,000 times) . o =|
Iterations | =4
Mean ID |
Std dewv |1 |
x Cancel._
Figure 11.22
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Continue Distribution of Sample Means. Selecting Continue in Figure 11.22 results in
a screen similar to the one shown in Figure 11.23. The histogram shows the
distribution of the 1,000 sample means of size n = 10 that were generated
from a normal distribution with mean = 0 and standard deviation = 1 (see
Figure 11.22). A normal distribution should have a skewness coefficient = 0.
The simulated values in Figure 11.23 (i.e., Mean =-0.00879, Std dev =
0.3179, Skewness = 0.02502) compare quite closely with those predicted by
theory.

8 Correlated lllustration E@@

Average | Standard Deviation | Skewness | Corelation

100
a0

a0
Average 70

Average

B0
50
40
a0

Skewness 002502 20
10

Average  -0.00873

St dew 03173

Carrelation 15 A 05 il 05 1 15

Show dats st

Histogram Bing ~ [30 =

Change Numbers

Figure 11.23

The Central Limit Theorem states that the distribution of sample means
should be normally distributed with mean equal to the population mean, i.e.,
0, and standard deviation equal to the population standard deviation divided
by the square root of x, i.e., 1/+/10 = 0.316. The shape of the histogram and
the Skewness coefficient of 0.02502 indicate that it is reasonable to assume
the values are normally distributed.

Note that the Histogram Bins box shows a value of 30. This is the number of
bars in the histogram plot. This value can be set to any number between 1
and 100. However, around 30 bins is usually a good choice for a sample of
1,000 values.

Distribution of Sample Standard Deviations. Selecting the Standard
Deviation tab in Figure 11.23 results in the screen shown in Figure 11.24.
The histogram shows the distribution of the 1,000 sample standard deviations
of size n =10 that were generated from a normal distribution with mean =0
and standard deviation = 1.

The average sample standard deviation is known to be a biased estimator for
the population standard deviation. It can be shown theoretically that the
average standard deviation for samples of size n = 10 taken from a
population with standard deviation = 1 should equal 0.9727. This compares
favorably with the simulated value of 0.97481.

PWLPay User’s Manual 11-10
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8 Correlated lllustration E@@
Average | Standard Deviation | Skewness Conelation

a5
Standard Deviation ?g
70
E5
Standard (=i}
Deviation ]
50
Average 037481 45
40
5
St dew n:22a02 an
25
20
Skewness 021638 15
il
3
1}

Caorrelation 0z 04 0B 0B 1 12 14 16 18

Show data set
Histogram Birs  [30 =
Change Mumbers
Figure 11.24

Unlike the distribution of sample means, the distribution of sample standard
deviations is not normally distributed, but is positively skewed, with the
degree of skewness decreasing as the sample size, n = 10 here, increases. The
skewness of 0.21638 for the simulated values is consistent with what would
be expected.

Distribution of Sample Skewness Coefficients. Selecting the Skewness tab
in Figure 11.23 results in the screen shown in Figure 11.25. The histogram
shows the distribution of the 1,000 sample skewness coefficients of size n =
10 that were generated from a normal distribution with mean =0 and
standard deviation = 1.

Since the values are simulated from a normal distribution, the average of the
1,000 skewness coefficients should be approximately 0, i.e., the skewness of
a normal distribution. In Figure 11.25, the average skewness coefficient of
-0.03692 compares favorably with the theoretical value of 0. It can be shown
theoretically that the standard deviation of the sample skewness coefficients
for samples of size n = 10 should be 0.687. This compares reasonably well
with the simulated value of 0.65425.

Distribution of Sample Correlation Coefficients. Selecting the Correlation
tab in Figure 11.23 results in the screen shown in Figure 11.26. The
histogram shows the distribution of the 1,000 sample correlation coefficients
of size n = 10 that were generated from a normal distribution with mean =0
and standard deviation = 1.

Since the values are simulated from two normal variables with 0 correlation,
the average of the 1,000 correlation coefficients should be approximately 0.
In Figure 11.26, the average skewness coefficient of -0.00977 compares
favorably with the theoretical value of 0. It can be shown theoretically that
the standard deviation of the sample correlation coefficients for samples of
size n =10 should be approximately 0.333. This compares favorably with the
simulated value of 0.33844.
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8 Correlated Illustration g@@

#verage | Standard Deviation | Skewness | Carrelation

100
Skewness 5

=le}
Skewness 70
B0
-0.03652
Averane 50
St desy 0. E5425 s
o
Skewness 011244 2
10
[t}
1} 1 2 i)

Correlation ] =2 A

Show data set

Histogram Bins |30 =)

Print Graph

Figure 11.25

B Correlated lllustration E@@

twverage | Standard Deviation | Skewness |

Carrelation 75

B5
=11}
Correlation 55
50
0.00977 43
Average 40
35
Std d 032244 30
=Y i
20
Skewness 0101562 15
10
g
0
o 05 1

Carrelation i 0.5

Show data set

Histogram Bins |30 5

Change Numbers

Figure 11.26

In Figure 11.26, the histogram is approximately symmetric as evidenced by
the skewness coefficient relatively close to 0. This is a unique case that
applies when the two populations that are being simulated have O correlation.
If there is either a positive or negative correlation between the two
populations, then the histogram of the sample correlation coefficients will be
skewed.

Figure 11.27 shows the input screen for the case where the two
characteristics to be simulated have a correlation of +0.5 between them. The
resulting histogram of the correlation coefficients is shown in Figure 11.28.
Note that the histogram is negatively skewed. The maximum possible value
for any individual sample correlation coefficient is +1.0. Therefore, the
sample cannot over estimate the population correlation by more than 0.5.
However, it is possible that the sample could under estimate the population
by a much greater amount (-1.5 in this problem). These facts lead to the
distribution shape shown in the histogram in Figure 11.28.
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¥ Correlated lllustration E@E]

Choose the number of characteristics for the example

Two Characteristics |

Enter the conelation coefficients between each pair of characteristics:

Characteristic Characteristic 2

Characteristic 1 I
Mode
) Random Normal Generator (3 Histogram (1000 ties) M =
Iterations | =
Mean 0
Std dewv 1

X Lancel

Figure 11.27

8 Correlated lllustration E@E]

Awerage | Standard Deviation | Skewness | Comelation |

Correlation =
70
Caorrelation
60
Awarage 048142 50
40
Std dew 0.26575 W0
20
Skewness 085825
10
1}
Caorrelation 0.5 0 05 1

Shov data set

Histogram Bins ~ [30 -

Change Numbers

Figure 11.28

If the two populations were negatively correlated, then the histogram of the
sample correlation coefficients would be positively correlated for the same

reasons. Figure 11.29 shows the sampling distributions for populations with
several different population correlation values.

Correlated  Correlated Random Numbers (See Figure 11.15) provides the user with a
Random Numbers  check of how well PWLPay is able to generate random values with the
correlation structure that is desired. It is another way to illustrate the
effectiveness of the random number generating routines used by PWLPay.
Selecting Correlated Random Numbers in Figure 11.15 opens the screen
shown in Figure 11.30.
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pvgz;g;a. T

@ Administiafion

Sedect the: number of Comelations

Enter the correlation cosfficients between each pair of characteristics:

Ct Ct 2 Cl & Ch 4 Ci 5

Charactsisic 1 | [ | |

Chaacienite ‘ | ] | |

Chasactric 3 [ ] T—

Eosrrsid) C ]
Numberof fesions [1o00m 3

auTPUT

Characteristic Characterisitc 2 Characterisitc 3 Characterisitc 4 Characterisitc &

Charsctarisitc | | | || |

Characterisitc 2 ‘ | ] | ] |
et e |

Figure 11.30

The Select the number of Correlations drop down menu allows the user to
select 2, 3, 4, or 5 characteristics for which to generate correlated random
values. Figure 11.31 shows the screen after the correlation coefficients for 5

correlated characteristics have been entered and Calculate has been selected.
As can be seen, the simulated values have similar correlation coefficients to
those desired.
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& pWL Pay
Fle Toos Navigate Help

Ve

¥
@ Administration

Select the number of Correlations
& v
Enter the canelation coefficients between each pai of characterstics:
Charactenistic Characterisitc 2 Characterisitc 3 Characterisitc 4 Characterisitc &
Chaacteisic A | las0 | oo | oo ‘
Chaistorilc 2 060 | Joso | oo ‘
G
Charactenisitc 4 0.40

Number of iterations __mn,nuu & -Eah:u\ata j
OuTPUT
Charactenistic Characterisitc 2 Characterisitc 3 Characterisitc 4 Characterisitc &
Coscentd 04015884201 | (D5016280886 |D.4004822488 | 03007514457 |
Charsctei 2 (05991640727 | [0.5012303883 | 0.3955530780 |
Chaactero 3 02004234138 | |3 eqe790857a
Charactenisitc 4 0.3577640044

Figure 11.31
Normality Testing

As discussed in Chapter 6, PWLPay can be configured to automatically run a
quick check for normality whenever new data are entered. PWLPay can also
perform two more detailed procedures to check for normality. These
procedures are illustrated in Chapter 6 and are discussed in more detail in the
following sections.

Anderson-Darling  There are a large number of statistical goodness of fit (GOF) tests. The
Test  typical PWLPay user may be familiar with GOF tests such as the Chi-Square
or Kolmogorov-Smirnov (K-S) tests. These are general purpose GOF tests
that are not particularly powerful for detecting departures from normality.

PWLPay uses the Anderson-Darling GOF test to identify data that do not
appear to have come from a normal population. The Anderson-Darling test,
like the K-S test, is based on differences between the cumulative distribution
of the observed data and that of the theoretical distribution against which the
data are being compared. However, unlike the K-S test statistic, which is
based on only the maximum individual difference, the Anderson-
Darling test statistic, 42, includes all of the sample values in its
calculation.

PWLPay uses a form of the Anderson-Darling test that has been
modified to apply specifically to testing for normality when the true
population mean and standard deviation are unknown and are

Important Note on
Sample Size for

Anderson-Darling - A
Test estimated from the sample mean and standard deviation values. The

procedure for this test is valid for sample sizes > 8.
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Table 11.1

qq-Plot

Computational Methods

Test Procedure. PWLPay performs all necessary calculations and notifies the
user whether or not the normality assumption is reasonable. As such, it is not
necessary for the user to understand the steps involved in the Anderson-
Darling GOF test. The steps are presented only briefly here for users who
may be interested. A more thorough description and explanation of the
Anderson-Darling test can be found in statistics texts.

Step 1: Arrange the n sample values in ascending order such that
X <x,<...2x,,<x,

Step 2: For all x;, calculate the standardized values y, = (x, —X)/s.

Step 3: For each sample value, i=1, ... , n, calculate P;, which is the area
under a standard normal curve that is less than or equal to the
standard score y;. This is the cumulative probability of obtaining a
value less than or equal to y;.

Step 4: Calculate the Anderson-Darling test statistic, 4%
A*==3[@i-D{In B +InQ-P,.. )}/ n]-n

i=1

Step 5. Calculate the modified test statistic, 4* (modified specifically for
testing for normality when 2 and ¢ are unknown):
A*= Az{l.O TN 2'225}

n n

Step 6: Reject the null hypothesis of normality if 4* exceeds the critical
value for the selected level of significance, «, in Table 11.1.

a 0.15 0.10 0.05 0.025 0.01
Critical A* 0.561 0.631 0.752 0.873 1.035

Since the Anderson-Darling test is quite sensitive to departures from
normality, in PWLPay it is always conducted at the 0.01 level of significance
regardless of what value has been selected with the Tools » Normality Check
» Alpha Value option.

The quantile-quantile (gg-) plot is a general method for determining if two
samples come from the same population. The gg-plot can also be used to
determine if one sample comes from a specific theoretical distribution
(simply replace the other sample by the target distribution), in which case it
is sometimes called a probability plot, or, particularly, a normal probability
plot if the target distribution is normal. PWLPay can develop and display
normal probability plots to evaluate whether or not a set of test data
reasonably approximate a normal distribution.
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The normal qg-plot plots the sample quantiles against the theoretical
quantiles (sometimes called the expected quantiles) of the standard normal
distribution. Suppose the sample is of size n. First, rank order the sample
values from lowest to highest. Take any observation x and record its rank .
Then x is the p(k)-quantile of the sample, where

p(k)=(k-0.5)/n

In other words, the probability of an observation being below x (or the k-th
order statistic) is p(k). This probability is usually taken to be simply /n, but
that would be biased for our purpose (see comments below). The expected
guantile associated with x is then the p(k)-quantile of the standard normal
distribution. For example, the 0.05 quantile of the standard normal
distribution is —1.645, i.e., a normal distribution has 0.05 of its area less than
or equal to a z value of —1.645. The p(k)-quantile values could be looked up
from the standard normal table, however, PWLPay automatically calculates
these values for the user.

While PWLPay uses the method shown above, other methods for determining
p(k) are also used. The most natual choice is obviously p(k) = k/n, which is
obviously biased when & = n since for a standard normal distribution only
positive infinity has a quantile of 1.0. Like the equation above, other versions
of p(k) attempt in some way to correct this bias.

Example 1: Computing the Expected Quantiles. Suppose the sample size is
n =50. After rank ordering the sample the 4™ smallest value is x = 10 (i.e.,
the rank for the observation x = 10 is 4). Then x = 10 is the

[(4-0.5) /50 =0.07] quantile of the sample. Thus the expected quantile
associated with x = 10 is the 0.07-quantile of the standard normal
distribution, which is —-1.476.

Drawing Conclusions. If the sample comes from the standard normal
distribution, the sample quantiles and theoretical quantiles should be very
close and thus the displayed points should fall around the straight line
passing through the origin with slope 1. If the sample comes from any
normal distribution, the displayed points should approximately fall in a
straight line (because any normal distribution is a linear transformation of the
standard normal distribution and thus the plot shifts and rotates the
previously described straight line, but it remains straight). Thus, a straight
line for the qg-plot indicates the sample comes from a normal distribution,
while any significant departure from linearity shows evidence against
normality.

Example 2: Interpreting qq-Plots. Figure 11.32 shows four probability
density functions, one for the standard normal distribution (Figure
11.32a), one for the normal distribution with mean 3 and standard
deviation 2 (Figure 11.32b), one for the ¢-distribution with degrees of
freedom 3 (Figure 11.32¢), and one for the y? -distribution with
degrees of freedom 5 (Figure 11.32d).
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N(z=0,0=1)
N(u=3,0=2)
(a) -0 0 10 (b) -10 0 10
t(df = 10) 7°df=5)
Figure 11.32  (c) -0 0 10 (d) o 10 20

Figure 11.33 shows gqg-plots for samples of size n = 200 drawn from the
populations shown in Figure 11.32. Clearly Figures 11.33a and 11.33b
indicate normality, while Figures 11.33¢ and 11.33d do not. It should be
noted that it is difficult to distinguish a ¢-distribution from the normal
using histograms. But the qg-plot is able to detect it. We know that ¢-
distributions are flatter and thus have heavier tails than the standard
normal distribution. Accordingly, the quantiles for the z-distributions
depart from those of the standard normal distribution at the lower end
and at the upper end, as can be seen from Figure 11.33c.

N(u=0,0=1) N(u=3,0=2) ]

Z-Value

A b & A o k9N w &
Z-Value

A b A B o ok oN w oa

4 3 2 a4 o 1 2 3 a 4 2 0 2 a 6 8 10
(a) sample Result (b) Sample Result

Chi-Sq(df = 5)

Z-Value
G b b A B o omoN ow &

Z-Value
A & A A o mo0N o w &

0 5 10 15

Figure 11.33 (C) * * * S;mpl; ReS:lt ! ° : (d) Sample Result
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